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Chapter 1
Introduction
       

DITAworks is a distinct Eclipse based platform, fully dedicated to the development and publishing
of XML DITA content and DITA information models. DITAworks features a complete documentation
management framework, based on the DITA architecture.

DITA (Darwin Information Typing Architecture) is the imperative OASIS standard for XML-based topic-
oriented authoring, information modeling, and structured single-source documentation. It adopts
and provides solutions for the most recognizable documentation principles, which are all supported
by visual and dialog based DITAworks tools. These principles include modularity and minimalism,
cross-topic hyper-linking above the topic scope, content re-use, conditional content processing and
publishing, and information typing by specializing the base DITA architecture info types.

DITAworks provides full tool support to DITA authoring, editing, styling, publishing, and information
typing through a diverse suite of content and modeling project development and management tools.

Another unique facet of DITAworks is its extensive support to documenting Eclipse applications. A
set of IDE tools is available to Eclipse developers and documentation specialists; not only to publish
user manuals to the Eclipse Help format, but also to author and integrate active and context sensitive
Eclipse Help pages. DITAworks provides a number of in-house developed DITA specializations to
facilitate the generation of effective Eclipse application help pages.

This manual guides authors through the process of developing and publishing content, based on
an existing model. Developing model projects is the subject of "DITAworks Guide for Information
Architects." It is worth mentioning that the set of DITAworks documentation is entirely written and
published using DITAworks, based on a model that is also developed using DITAworks.

 1.1 Core Areas

DITAworks is characterized by three core areas that set it as the distinct platform dedicated to
producing and managing large scale DITA XML documentation.

Information modeling

DITAworks is equipped with a set of visual tools to support the information architect in developing
specialization and generalization models and in preparing custom templates for authoring, element
transformation, and output styling.

Documentation process

DITAworks is more than just a platform for authoring and publishing documents in DITA. It further
provides a framework for full single-sourced documentation lifecycle management. DITAworks is
designed with scalable on-going documentation processes in mind.

Publishing and export

DITAworks provides extensive processing support for publishing content to a wide range of print and
online media. With an extension for server side publishing and support for stylesheet authoring and
customization, it is well suited for large scale publishing processes.
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The below table summarizes DITAworks three core areas.

 

 1.2 Use cases
  

Following are some of the potential areas, where DITAworks shall make a solid platform to effectively
support DITA methodology of managing and publishing information in various possible forms and
media.

1. Structured document authoring, publishing and management:

• Large technical, scientific, and market reports

• Business documents such as tenders, RFPs, contracts, etc.

• Integrating data from other sources such as databases and content management systems

2. Single source publishing:

• Development and management of product user manuals

• Documentation of product technical design

• Context sensitive help and online help systems

• Training and e-learning material

• Large-scale documentation lifecycle management

3. Producing specializations and customizations for DITA based publishers

4. Generation of software help pages in various standard formats, with special provisions for
producing integrated and context sensitive help procedures for the popular Eclipse development
environment
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Why DITAworks: A dedicated DITA authoring and modeling tool?

XML authoring tools often provide different levels of DITA support. In most of the cases tool providers
that claim to support DITA, do so only partially.

DITAworks is designed with DITA as main information architecture and thus it supports all aspects
of DITA and additionally it addresses the intricacies of DITA authoring in a capacity that may not be
affordable by general purpose XML development tools (or generic XML editors). DITAworks focus on
"open" DITA based authoring and publishing needs distinguishes it from other documentation tools
that may have DITA as just one of the several supported authoring modes.

More specifically, DITAworks offers:

• Optimized design based on open standard: Unlike most production systems that offer
proprietary single source implementations, DITAworks was designed based on DITA as its
primary information architecture. The system enables and optimizes all concepts that DITA is
built upon, including support of specialization. This makes DITAworks a truly specialized DITA
platform.

• Integrated workplace: DITAworks integrates all functions needed by authors, reviewers, and
information architects for efficient work with documentation based on DITA. Users do not need to
switch between different work tools.

• Extensibility: DITAworks can be easily used as a base platform or a component for custom
solutions that require systematic management of structured documentation. Since DITAworks
is built on top of Eclipse RCP platform, it can be easily integrated with other Eclipse-based
solutions.

• Modeling support: DITAworks features unique DITA Specialization support, which is a novel
offering amongst DITA tools. On one hand, DITAworks modeling components provide simplified
visual ways to create DITA specializations. On another, any specialization created in this way can
immediately be used in all of the authoring and publishing components of DITAworks.

• Full support of Eclipse help: DITAworks provides extensive support of Eclipse Help format
based on DITA, which makes it the ideal tool for integrated and context sensitive documentation
of Eclipse applications.

 1.3 Features
              

DITAworks is built using state of the art functional software components, while featuring a rich and
highly customisable Eclipse-based graphical user interface.

The following enlists DITAworks features by area.

Reference and functional components:

• OASIS DITA 1.1 language and architecture specifications

• OASIS DITA Open Toolkit 1.5

• <oXygen/>® XML Editor 10.x

• Eclipse RCP 3.4

• Built-in Eclipse Help and other DITA specializations

• Java Runtime Environment JRE 6
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Editing and navigation features:

• Rich and highly customizable Eclipse based user interface

• Project Explorer and Map Manager views

• Customizable template-based topic and map creation and partial population with skeleton
elements

• Customizable project scope settings

• Integrated HTML topics and maps preview

• Support of nested DITA maps

• Text/Source and Author (WYSIWYG) editing modes for topics and maps

• Visual relationship table editor

• Valid element and attribute drop down menu while editing

• Integrated image viewer

• Built-in screenshot facility

• Fast and detailed search, throughout different contexts, employing infamous regular expressions

• Importing and exporting content

• Link management and refactoring support

• Support of collaborative authoring and version control

Eclipse Help support:

DITAworks uniquely provides extended support for both independent and development-integrated
Eclipse Help production

• Appropriate specialized types for support eclipse help and eclipse help contexts

• Import of existing Eclipse help plug-in content

• Tools for integration with development process (Context IDs management between development
and documentation teams)

• Plug-in for Eclipse IDE enabling easy context help mapping

• Context ID synchronization wizards

• Support of dynamic context ID mapping (DTP approach)

• Eclipse help specific validations

• Support of active help features inside of help content(calling Eclipse commands, links to cheat
sheets, etc.)

Publishing features:

DITAworks can be used to publish DITA maps to any of the standard types, including those built in the
DITA OT. In addition, DITAworks supports customising standard transformation and styling sheets to
enable arbitrary user-defined output forms. That's in addition to several desirable publishing features,
listed below.

• The following output types are supported

• PDF
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• XHTML

• Eclipse Help with contexts

• Java Help

• HTML Help

• DocBook

• Troff

• RTF

• SCORM

• Configurable Publishing Manager with advanced features, such as

• Conditional publishing profiles

• Link resolution detecting and resolving links out of map scope

• Additional variable and parameter definition capability

• Server-side publishing support

Modeling features:

• Dedicated user interface perspective for modeling projects

• Extensive specialization support

• Structural specializations

• Domain specializations

• Attribute specializations

• Template support

• Transformation and styling customization support

• Model validation, testing, and publishing support

• Import of models from DTD

• Export models in form of DTD, XML Schema or DITA OT Plugin

 1.4 Computing requirements

Minimum hardware: Pentium 4, 1.5 GHz, 512MB of RAM, 200MB of disk space (for application only,
excluding space needed for projects)

Operating system: The application runs over own integrated Java and Eclipse platform, so it is
independent of operating systems as long as proper Java Runtime Environment can be installed

Minimum recommended Windows installation: Windows XP SP2

Software: Tool package includes integrated JRE 1.6 and Eclipse platform 3.4
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 1.5 Using this manual
It is recommended for all users to become familiar with the introductory chapters:

• Introduction

• Getting Started

• The User Interface

Authors with limited DITA and/or structured authoring tools experience, will benefit from the help
material in the following chapters:

• Developing Content Projects

• Authoring DITA topics

• Developing DITA maps

• Publishing DITA maps

Advanced authors, authors in a collaborative authoring environment, as well as authors involved in
documenting Eclipse based software will find specific interest in visiting the following sections:

• Reusing Content

• Version Control

• Developing Eclipse Help

Authors involved in style sheets and information modeling will find it useful to consult the "DITAworks
Guide for Information Architects."

The appendix contains the following reference information, of interest to a wide range of users:

• User interface views and menus

• Publishing parameters

• Eclipse Help specializations content models

The following editorial conventions have been used throughout this manual:

• User Interface keywords (names of menus, menu items, toolbar icons, perspectives, dialog
windows, and tabs) are represented as:  menu name » option » sub-option

• Names of windows, window fields, and properties, are represented as: Window name

• Code phrases and fragments, including DITA markup are represented using this font:
codePhrase

Note: "DITAworks Guide for Authors" assumes user knowledge of DITA language and architecture
concepts and specifications. In addition to this "Introduction" chapter, users can find informative DITA
reference resources in the appendix "DITA References".
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Chapter 2
Initializing and Maintaining DITAworks
This chapter provides the needed information about installing, licensing, running, and updating the
DITAworks application.

 2.1 Installing DITAworks

DITAworks is shipped as a Zip package that contains all its integrated components [page 7], including
the Java Runtime Environment. To install:

1. Request an application package at http://www.ditaworks.com/dl

2. Create a "root" folder to contain the Zip package contents on any drive at your PC. Ensure that
the full path to the root folder does not contain spaces.

3. Extract the Zip contents into the designated folder

Note: There is no uninstallation procedure for DITAworks. If you need to remove the application,
just delete the folder where you had extracted the application's Zip package.

 2.2 Registering license key
Upon registering on site (http://www.ditaworks.com/dl) for an evaluation version, or purchasing a
commercial DITAworks edition, a license key file will be emailed to you. To register the license:

1. At the main menu bar, select  Help » License » License Wizard .

The License Activation Wizard will be launched.

2. At the first dialog window, select one of the following two methods for registration by checking the
respective radio button; then click Next.

• Professional Edition: In case you do not have a license key yet.

• Install License File: If you have already registered and have obtained a license key file.

 

http://www.ditaworks.com/dl
http://www.ditaworks.com/dl
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3. If you already have a license key file, skip this step. If you have not yet registered, check the
Professional Edition radio button, and click Next

a. You will be presented with a Product Registration window. Fill in the required information;
and click Next

 

b. An Email Activation window will appear, providing you with a text block composed of the
registration information you entered in the previous step. Copy the text block and paste
it into an email, from your registered email address, to the email address provided in this
window.
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c. An email will be sent to your registered address with a license key file attachment. Save the
key file by clicking Next

4. Now that you have registered and received the license key file, or already had a valid one, click
Browse to launch file selector and select the key file; then click Finish.

 

5. Click Finish

License key will be uploaded to DITAworks authentication server and your DITAworks application
should be now operational according to the license terms of usage.

A registration confirmation window will popup, with the detailed license information, including
DITAworks edition and validity period.
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 2.3 Running the application
To run DITAworks, go into the folder where the Zip package has been extracted, and double-click the
file ditaworks.exe.

 2.4 Updating the application

DITAworks provides a convenient update mechanism that allows user to get latest updates for the
application.

Note: In case you have no direct connection to the Internet and are using Proxy server, you should
ensure before performing an update that the proxy is defined in your Internet connections settings at 
Window » Preferences General » Network Connection

1. Go to the  Help » Software Updates » Find and Install

 

The dialog window Install/Update: Feature Updates is invoked.

2. Select search for updates for currently installed features and press Finish

System will ask you for your login and password. After that, the system will check for available
updates. If new updates are available, system will guide you through the update download and
installation procedure.

3. After installing the updates, the application needs to be restarted.
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Chapter 3
The User Interface
DITAworks user interface is based on the Eclipse user interface components. The application window
(workbench window) may present one of two perspectives: Editing or Modeling. A perspective is a
visual container for a set of functional views and editors. Each perspective provides full functions to
work with the respective resources and achieve the desired results. It defines the set and layout of
views in the application window. Perspectives typically share many application features, while they
differ in some features that enable each to perform its designated feature.

 3.1 Overall layout

The user interface consists of one or more of each of the following visual functional components:

• Workbench window: The overall outer application window.

• Perspective: A set of user interface elements arranged in certain layout that offers a related set
of functions (for either editing or modeling). Perspectives may differ by available set of views,
their positions, and their layout.

• Menu bar: The fixed functions bar at the top of the workbench, just below the window title. The
functional options provided by the menu bar cover the full interface functionality.

• Tool bar: A window component that is located below the menu bar. Iconized shortcuts of most
common functions can be dragged and placed at the tool bar for usage convenience. Available
buttons on the toolbar can be adjusted via context menu action "customize Perspective...".

• Docking areas: Work areas, each supporting a number of views designated and opened by
tabs at the top of the area. Some docking areas have a fixed functionality (e.g. the editor area).
Others have default view functionality that can be re-arranged to the users' preference.

• Editor: A fixed function work area, dedicated for editing, where tabs represent open files.

• Views: A view is opened by clicking its respective tab in its home work area. Some views can be
moved across work areas, by dragging and dropping their tabs, to match users' preference. New
views can be open via  Window » Show View  main menu item.

• Status line: A line at the bottom of the application window used to indicate status of open editors
(such as file editors) or dynamic processes (such as a validation or publishing process).

• Shortcut menus: Iconized menus, designated by dotted lines on their left sides, that can be
dragged between task bars to match users' preference.
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All view setups described are the default DITAworks layout. Most tabs at the different view and task
bars can be dragged and dropped for arrangement to the user's best convenience. You can revert to
the default view at any time, in case you made arbitrary layout changes.

DITAworks user interface functions can be completely described by describing the functions (of each
instance) of its components, as per the following table.

UI component Function
Menu bar Provides the application main menu; each menu with a number of options. The

functions provided by the menu bar cover all application's functions that can be
invoked via shortcuts or through dialog windows.

Task bar The task bar is a place where commonly used functional icons can be dragged
to for easy access. All icons on a task bar are redundant shortcuts and can be
reached from the menu bar or from context menus.

Perspective bar Allows the user to switch between editing and modeling perspectives (modes of
operation) via the two tabs at the top right.

Editor Provides the area to open, edit, and save topic and map files. It is also possible to
open read only resources within the editor view, such as image files.

Views Available views depend on the current perspective (Editing or Modeling)

Status line Provides several status related indicators, most important the validation, project
build, and document publish status and progress bar.
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 3.2 Perspectives

DITAworks user interface features two perspectives:

• Editing Perspective: Provides the functional interface components required for working with
content projects; topic and map editing, validation, and publishing output documents. The editing
perspective is most commonly used by DITA authors and information developers.

• Modeling Perspective: Provides the functional interface components required for modeling
projects, such as specializations and publishing template customization. The modeling
perspective is most commonly used by information designers and architects.

While both editing and modeling perspectives share several views, each of them is characterized by a
number of dedicated view.

 3.3 The Editor Area

The editor area is the most prominent UI part. Editing area is available in all perspectives and it hosts
the file editors of different types, i.e DITA topics, maps, graphic files, etc.

DITAworks topic editor is based on oXygen® XML editor. It comprises two modes for editing:

• Text mode: Enables direct access to XML source of the topic. User needs to be aware of DITA
topics source markup (elements and their content model).

• Author mode: A WYSIWYG view, where users can choose to display DITA markup in a visual
form and edit content in Word-like style.

DITAworks map editor comprises two modes of editing:

• Source mode: Enables direct access to XML source of the map. User can only edit using source
markup defined for the subject DITA map (similar to the topic Text editor)

• Structure mode: User can edit the map using a visual representation in mind map style that
provides menu based support for adding, deleting, editing, and arranging map references to
topics and other resource files.

DITAworks also provides other types of editors that can be open in editor area. Among others are:

• Graphical file editor

• DITA Infotype editor

• DITA Domain editor

• Decoration editor

 3.4 Editing perspective views

DITAworks user interface offers several views to support authors in effectively editing and publishing
content. Some views are made available in the default workbench layout, and others can be invoked
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by the user. Also, there are views that are common to both the Editing and Modeling perspectives,
while there are other views that are specific to each. The " DITAworks Guide for Authors" is concerned
with all views that are pertinent to the Editing perspective.

To bring about a view that is not currently shown, select  Window » Show view  at the main menu bar,
and click the view you wish to invoke.

 

The table below lists and describes the views that are pertinent only to the editing perspective.

View name Function
Project Explorer A "File Explorer" like view that displays expandable folders that start at the project

level, with project resource folders with each project folder, down to topic, map,
image, output and other arbitrary resource or result files. Files can be opened in
the Editor area by double clicking a file name. Other functions can be called from
context menu.

Map Manager A view that displays selected DITA map in form of expandable topic tree with topic
names. It provides possibility to navigate via selected map, perform basic editing
operations and open referenced topics.

Preview Provides a formatted display of the DITA topic/map that is currently selected or
edited

Properties Provides a table displaying all valid attributes, and their current values, of the
current context element in the file being edited

Outline Provides an expandable/collapsible view of the element hierarchy within the file
being edited

Reuse Displays all user defined reusable elements consisting of variables, text blocks or
text templates.

Tags Displays all DITA standard and user defined attributes used for conditional
processing (content tagging).

Relationship Table Provides a visual representation of relationship table for active map editor.

Console Provides a read-only display of console messages as they occur, while editing,
publishing, working with version control, etc. This view can display several different
consoles. they can be switched using "Open Console" button on the top-right
corner of the view.
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Problems Displays errors and warnings that resulted from running a validation or publishing
process inside your workspace.

Error Log Displays application errors and warnings. Using context menu application errors
can be reported to application vendor.

Progress Displays the detailed processing operations that take place upon running a
validation or publishing process on a DITA map or topic

Search Provides the results of a search operation
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Chapter 4
Developing Content Projects
Developing content projects is mainly comprised of authoring topics and organizing them in maps.
Topics and maps (and other resources, such as images) may be authored from scratch or may be
imported. The authoring environment is managed by setting content project properties. DITAworks
provides tool support for the creation, editing, importing and exporting, managing links, and navigating
topic and map files. This chapter walks you through the process of developing content projects.

 4.1 Project structure

It is essential to first have an overall understanding of the DITAworks project structure. There are two
types of DITAworks projects:

• Content Projects: Act as file system containers to store DITA resources such as topics, maps,
images, etc., managed and visually presented by DITAworks. The folder structure within the
content project is not fixed and it can follow the content design decisions made by the authoring
team. Some files in the project structure are created automatically by DITAworks upon the project
creation and are (optionally) hidden from the author. Content projects are marked in the Project

Explorer view using this icon: .

• Model Projects: Act as file system containers to store model objects such as DTDs, metadata,
rules, parameters, style sheets, etc. These model objects define the rules that the source
authoring must conform to and contain the style sheets that control the content presentation
when published to a particular format. Each content project must be associated with a model
project. The same model can be used with any number of content projects. Model projects are

marked in the Project Explorer view using this icon: .

Related content and/or model projects are contained within a DITAworks storage area called
workspace. Only one workspace can be open in DITAworks at a time, but multiple workspaces can
be easily switched using  File » Switch workspace  menu option. The author typically works within
the bounds of a particular project, or possibly a workspace, but is not concerned about the way a
workspace is setup.

Projects are displayed in Project Explorer view. A set of related content and/or model projects forms
the DITAworks workspace.

DITAworks enables the user to define several project level settings, which enforce uniform conventions
among project resource files and DITA document elements. These properties include:

• Element ID generation conventions: These conventions define rules for generating new IDs for
topics and topic elements.

• Topic and map file naming conventions: Determine how newly created topic and map files will be
named.

• Storage policy for project files: Determine where newly created topic and map files will be stored.
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• File name decoration with labels within the Project Explorer view.

Each of the above settings can contain a mix of fixed alphanumeric characters and project related
variables. The use of variables relate each project level property to the file or element it is associated
with.

The below schematic illustrates the DITAworks content project structure within the overall authoring
and publishing context, by highlighting the following concepts:

• A content project consists of topics that are arranged within maps.

• Content can be authored from scratch or imported from previously existing projects/resources.

• The authoring environment related parameters of a content project are set using the content
project properties.

• The authoring and publishing rules are governed by an associated model project.

• The transformation profiles defined within the associated model project control the final from and
presentation of the published content.

 

 4.2 Creating new Content Projects

To create a new Content Project, you need to invoke and follow a simple wizard that guides you
through the proper creation process, as follows:

1. At the main menu bar, select  File » New » DITA Content Project , to invoke the dialog window
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2. Enter a Project name; and click Next

3. Select a Project template, and an associated Model project by highlighting the respective
thumbnails using the left mouse button; then click Next.
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Model that is selected in area "Modeling project" represent the primary model that future content
project will be associated with.

Project templates define certain set of project settings and project pre-created infrastructure. The
table below explains the implications of choosing each template.

Project template Model project

Standard This template is used to create an empty content project

Eclipse Help plugin This template creates an Eclipse help project based on the DITAworks Eclipse
Help specialization. It results in creating one predefined eclipsehelpplugin
and another predefined eclipsecontexts map, as well as setting predefined
conventions and a storage policy. EclipseHelp model will be automatically
selected for this template.

Infotype based This template results in creating a content project with predefined file layout,
where different types of topics and maps are stored in separate folders. It also
defines a set of predefined naming conventions. You can choose any of models
available in your installation.

The Create a new model project button in this window will launch the model project creation
wizard. In this way a new model can be immediately created and assigned to current content
project. Typically, the model would have been created earlier, which would result in that model
appearing in the creation wizard window.
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4. On this step define project deliverables. Project deliverables are the documents that you plan to
get as a result of your content work. You can use Add button to add new documents and their
types. Based on this information Content project creation wizard will create empty DITA maps
with associated transformation profiles. You can also define you deliverables later, by manual
creation of new DITA maps and transformation profiles.

 

5. Click Finish to exit the creation wizard.
When the content project is created and its properties set, you may begin creating and developing
DITA topics and maps for publishing. These topics and maps are stored within their respective project
folders as specified by user or project storing rules.

 4.3 Setting Content Project properties

Content project properties are a set of organizational rules that apply within the scope of the subject
project. Properties offer flexible choices that enable the user to enforce consistent authoring and
content management conventions within the project structure.

1. To launch the Properties setup window, select the project in the Project Explorer view by left
clicking your mouse and make the menu selection in one of the following ways:

• In the Project Explorer view, select  File » Properties ; or

• Right click your mouse and select Properties from the drop down context menu.
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2. You can set rules for a number of project properties, as explained in the following table.

Property Description

Resource In this window, you can set the text file encoding and line delimiter, or you
can choose to reset to defaults.

DITA IDs and file names within the project scope are defined using expressions
that consist of a sequence of variables (contained in curly brackets). Each
variable represents a project topic, or element related properties and can
assume one of a limited set of values (character strings). The use of these
expressions therefore enables the automation for generating unique names
in a way that relates to the resource referenced by the name.

DITA » ID Generation IDs apply to DITA documents (topics and maps) as well as to the elements
that comprise a document. They enable making a unique reference to their
respective document or element. ID expression variables are selected from a
list, invoked by clicking the Add Variable button next to this option.
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DITA » File Naming
Conventions

Project files may contain topics, maps, images, or any other resources that
can be referenced from a DITA document. File name expression variables
are selected from a list, invoked by clicking the Add Variable button next to
this option.

 

DITA » Storage Policy A storage policy is comprised of a set of rules defining the storage locations
for newly created topics, maps, and other resource files. It can be enabled by
checking the radio button at the top of the Properties window. New rules can
be added and existing rules (in view) can be edited or deleted. Rule order
can be changed by shifting rules with the up and down buttons.

Project References This property page is used to enable a project to refer to one or more other
projects in the workspace. The user may select projects to be referenced
among the list of projects in the workspace, by checking the respective box.
Content projects are referencing Model projects in this way.
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Refactoring History This page displays a list of past refactoring attempts.

Validation This page provides means for customizing validation scenarios, in addition to
the default ones provided by DITAworks.

Variables derive from project and topic/map properties, as illustrated below (when the list is
invoked by clicking the Add variables button).

 

For example;

• {INFOTYPE}_{Title} will be expanded to infotype name in capital letters, followed by
an underscore sign and then by topic title. When applied to a concept topic titled 'About
DITAworks', the generated file name will be 'CONCEPT_About_DITAworks.dita'

• {FLInfoType}_{Title} will be expanded to the first letter of infotype name in upper case,
followed by underscore sign and then by topic title. When applied to the same concept topic
above, the generated file name will be 'C_About_DITAworks.dita'

3. To define file name decorations (labels) that get displayed next to file names within the Project
Explorer view, select  Window » Preferences , expand the DITA options and highlight Label
decoration. Define label decorations for topics and for maps by entering a sequence of variables
just like you did with the ID generation and the File Naming Conventions above.

 



Chapter 4 Developing Content Projects / 4.4 Importing content
DITAworks Guide for Authors

28

 4.4 Importing content
Importing content is the proper way to bring in content from a resource that is external to the subject
content project. You can import content, using a set of available wizards. Following import options are
supported:

• You can import external DITA content by selecting  File » Import » DITA » Import DITA
content .

• You can import external DITAworks project to you workspace by selecting  File » Import »
General » Existing Project into workspace .

• You can import external Eclipse Help content by selecting  File » Import » DITA » Eclipse
help .

• You can import external HTML content by selecting  File » Import » DITA » HTML .

Importing external DITA content

To import external DITA content to your project, invoke the DITA Import wizard by following these
steps:

1. To invoke the external DITA content import wizard, select  File » Import  at the main menu,
expand the DITA folder, and highlight Import DITA content; then click Next.
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2. At the popup window DITA content import, select the import source and target folders.

3. Click Browse to select the "From" and "To" folders. Check mark the boxes next to the resource
files that you wish to import, according to whether you want to apply the target project naming
conventions and/or storage policy; and click Finish.
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The selected resource files have now been imported to the destination that you had chosen.

 4.5 Exporting content
You can export content to another project, to a server, or to a folder in the local file system, using a
simple wizard.

1. To invoke the content export wizard, select  File » Export  at the main menu bar.

 



Chapter 4 Developing Content Projects / 4.5 Exporting content
DITAworks Guide for Authors

31

A window titled Export: Select pops up. It features a text filter to help you fetch resources form
the variety of available locations.

2. Identify the location that you wish to export to.

• To export DITA content to another DITAworks project, expand the DITA folder and select
the target project, expand it; and click Next.

• To export to a network or a file system resource, select the resource folder; and click Next.

3. Let us assume that you wish to export a resource from the local file system. Expand the General
folder icon, highlight the File System folder icon; and click Next. You are then presented with a
Export: File System window.

4. Click Browse to select the "From" and "To" folders. Checkmark the boxes next to the resource
files that you wish to import; and click Finish.
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The selected resource files have now been exported to the destination that you had chosen.

 4.6 Link management and refactoring
 

Link management

DITA topics can make reference to external and internal resources. External references, typically,
to a network URL, are made using the <xref> element. The URL may point to a web page, an
email address, or any other public and addressable resource. Internal references are made using
elements like image (via the <href> attribute), conref (when reusing an element's content by ID),
and related-links (used to include related topics via navigational hyperlinks).

DITA content is known to be of high granularity. As the number of topics and internal resources
builds up within a content project, it becomes hard (and possibly intractable) to maintain link validity
and consistency. This is because the DITA author may rename or move resources without carefully
updating all references to such resources.

DITAworks extracts all links from their source files, as they are saved in a project, and stores them in a
special index where validity and consistency are managed. This process offers the following features:

• Automatic link extraction and validation

• Link visualization and navigation

• Link preservation during and after rename and move operations

DITAworks names two types of links:
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• Outgoing links, which refer to external or project resources from within the subject topic or map
file.

• Incoming links, which refer to the subject topic or map file from another file.

In the Project Explorer view, each topic or map file icon is actually an expandable/collapsible object.
You can observe the familiar "+/-" signs next to the file name icon, which has a folder appearance (and
not a file appearance) as an indication of its being parent to outgoing and/or incoming links.

 

Link refactoring

The term refactoring refers to preserving link integrity when the referenced resource had been
renamed or moved, using a link indexing mechanism. The extracted link index is used by DITAworks
for a number of other functionalities such as XML document validation.

You can try the following example to see how refactoring a resource link works in practice. In this
example, we will rename and move an image that is referenced from several DITA topics. DITAworks
automatically updates all DITA links to the image.

1. Expand the Incoming Links object of an image file, noting the number of topics that it is
referenced from (six topics in this example).

2. Highlight the image file name and select Rename using the right mouse button drop down menu.

3. Rename the image file within the Rename Resource window.

4. Check that each of the topics that referenced the "renamed" image file has updated the file
name. You can do that in the Project Explorer view, by expanding the Outgoing links object
underneath each topic file name and verifying that the name had been updated.

Note:

The same above example can be tried with a "move" operation.
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 4.7 Navigating Content Projects

DITAworks features several tools to support navigating and locating project resources.

• Project Explorer: Located at the top left docking area by default, it enables you to browse
projects, project folders, and resource files in a conventional view that is similar to the Windows
"File Explorer" view.

• Label decoration: You can choose to insert descriptive text labels between the topic and/or map
file icons and the respective file names at the Project Explorer view. Labels make it easier to
visually identify topics by type, version, title, or another attribute that you may choose. You can
invoke the Label decoration configuration window at the main menu bar, by selecting  Window
» Properties » DITA » Label decoration .

The image below is an illustration of concept topic files in File Explorer view, decorated with
the character "C"(abbreviation for "concept") ahead of the file name and with the topic title and
version following the file name.
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• Open resource: If you are missing the full name of any resource file within your projects view,
you can look it up by entering a string that the resource name contains and selecting from the
resulting list of found resources. You can do that by selecting  Navigate » Open resource  or
clicking Open resource... button in the main menu bar or via keyboard shortcut Ctrl-Shift-R.

The image below is an illustration of Open resource window. Resources can be looked up by
typing parts of resource names. Wild cards like "*" and "?" can be used.

 

• Search: You can search for files by name string or content text string using this window. All
searches are "regular expressions" (regex) enabled. You can invoke the Search window at the
main menu by selecting  Search » Search  or  Search » File . If you wish to search by text, you
can perform a power search by highlighting the text in your current editor view and then invoking
a search agent within one of the following possible search spaces. At the main menu, select 
Search » Text » Workspace ,  Search » Text » Project ,  Search » Text » File , or  Search »
Text » Working Set  to define the search context.
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Chapter 5
Authoring DITA Topics
The topic authoring process includes topic creation, editing, previewing, validating, and possibly
publishing (to test exact output presentation when necessary). This chapter describes the functions
involved in topic authoring.

It is important for the DITA author to have a topic plan before starting to author and edit topics.
This plan should identify the specific purpose, and consequently the type, of each topic. DITAworks
supports the author in modifying the topic plan at any point during the project's lifetime, through the
Project Explorer and the Map Manager views.

 5.1 Creating new topics
To create a new DITA topic, you need to assign it a type, a title, and make a selection among a
number of editing support functions. The wizard procedure is optional and will appear only when
optional Classification module is installed.

1. You can invoke the topic creation wizard in one of two ways:

• At the main menu bar, select  File » New » DITA Topic ; or

• Use the context menu, by right clicking the topic parent folder, and select  New » DITA
Topic
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2. Within the wizard's dialog window, assign a title to the topic; and click Next

Note: The topic file name can also be generated from the topic title according to the setting
previously done at the  Project » Properties .
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3. Select the topic type among the following standard supported types:

• concept

• glossary

• reference

• task

• topic

Note: The available topic types and templates are not restricted to those defined by DITA
1.1 specification. For example, the above listed topic types are the most important subset of
standard DITA 1.1 types and they could be amended or reduced. Topic types and templates can
include user defined ones, as determined by the model assigned to current content project.

4. Select the thumbnail that represents the template you wish to have generated automatically, by
highlighting it and double clicking your left mouse button.

Note: A topic file template is meant to help the user focus on authoring based on a set of pre-
populated declarations and elements. DITAworks may ship with a number of in-house defined
topic and map templates. The displayed templates to choose from depend on the used model.
Users can define their own templates, as a part of their own developed models.
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Topic template Description of contents

Topic Creates the required XML and DOCTYPE declarations, as well as the root topic
element of the selected type (also called a blank template)

..other.. Additional templates can be defined by user in model project.

5. By default, the new topic will be created in currently selected project, as seen in the Destination
project field. To select a location other than the default, invoke the Select project window by
clicking Browse, select a project by highlighting its name, and click OK.

6. Select among the following auto creation support functions, by checking the corresponding box:

Note: This step will be encountered only in case you select the blank template.

• Create optional attributes

• Create optional elements

• Create first choice of required data (recommended)

• Fill elements and attributes with data (recommended)

7. Your current project storage policy (if activated for your content project) determines the default
location for the topic being created. To select a location other than the default, invoke the Select
project window by clicking Browse, select a project by highlighting its name, and click OK.
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Note: Default location for the topic can be changed only in case storage rules activated for
current content project are not mandatory

The selected project name will now appear in the Destination project field.

8. Click Finish.
The newly created file appears under the corresponding topic type folder in the Project Explorer view.
The new topic's tab and editing window appear in the editing view.

 5.2 Editing topic content

DITAworks topic editor is based on <oXygen>® XML editor, which provides a rich set of editing
functions. Editing can take place in one of the following two modes: Text and Author.

Following are the general steps for editing an existing DITA topic.

1. If the topic file is not open, you can open it by double clicking the file name in the Project
Explorer or the Map Manager (if the topic has been referenced by a map) window. When the file
is open, a tab with the file name appears at the top of the editing area and a file editing view is
open.

2. You can now start populating the topic with elements and content. You can do that in one of two
views (represented by the tabs at the bottom left corner of the editing view).

Note: The view that you choose for editing depends on several factors such as personal
preference, familiarity with DITA markup (elements and attributes), nature of topic content, and
the editing stage you are at.

• Use the Text view if you are familiar with DITA/XML markup and when you need to closely
inspect topic content .
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• Use the Author view when you wish to avoid interpreting the detailed XML document
structure and have a general visual feel of how the content structure may be presented in a
WYSIWYG editing environment.
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3. When you are finished with editing, you can save the file at the menu option  File » Save . You
can save all open files at once by selecting the menu option  File » Save All .

Note: In some instances, newly inserted references to other internal resources (using the href
attribute with the image element for example), will not be resolved before you had saved the file.

5.2.1 Text editing mode

The Text mode (also called source mode) offers the following features.

• Content completion assist:  When typing new XML elements or attributes, editor will propose
only valid options. See example element and attribute suggestions below.
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• Integrated preview for referenced topic: Hold the Ctrl key down and move your mouse over
reference to a topic (preview is also available in a separate view)

• Automated source formatting: Highlight the text to be formatted, click the right button to invoke
the context menu, and select  Source » Format and Indent Element  (or press Ctrl + Shift + F)

• On-the-fly validation: validation errors are highlighted while editing

• Refactoring operations: available via context menu option Refactoring

• Integrated object selectors: Easy selection of valid objects when defining href or conref
attributes

The object selector function is demonstrated by the following example and illustrated in the screen
below. Let us try to define a conref for one of our content elements: a step element inside a task
topic. Follow the steps below.

1. Open an existing task in topic editor in Source mode.

2. Find a step element and type 'conref' there.

3. The object selector window opens, where you can browse for the target task topic and the
step element inside of it. Preview is available on the right side of the selector and all matching
step elements are highlighted by vertical green lines to the left of the text bodies.

4. In case the selected step does not have an ID assigned, it will be automatically generated
according to the pre-defined ID generation rule, and assigned to the selected element. This ID
will be used in conref reference.

5. A valid conref value is set.

6. If you try to change this value and save, validation will detect errors in reference and report it to
you.
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The screen below focuses on Refactoring context menu operations. This menu can be called from
anywhere within the editor area.
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5.2.2 Author editing mode

This mode offers the following features.

• Tool bar buttons:  Used for fast access to certain editing operations like creating links, defining
conrefs, table operations, etc.

• Customizable WYSIWYG styles:  Style sheet (CSS) can be selected from the drop down menu
at main tool bar. Additional styles that can be defined at the model level would appear in the
same menu as extra choices (consult "DITAworks Guide for Information Architects" for more
detailed information).

The following provides a summary of the most common functions offered by the Author  editing mode,
via the toolbar icon buttons illustrated in the below screen shot.

 

• Tagging:  You can select different levels of element and/or attribute displaying DITA XML tags, to
get both advantages of editing in a WYSIWYG environment while maintaining the markup view.
The below screen illustrates the Author editing mode when the option Block Tags is selected at
the Tagging options drop down menu.
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• Inserting tables:  The toolbar button Insert a DITA Table enables you to insert a table element,
after assigning it a title and selecting the initial number of rows and columns. After the table has
been inserted, you can manipulate its configuration by adding or deleting rows, columns, and/
or individual cells. You can edit the table element attributes in the same mode by displaying tags
with attributes.

• Inserting images:  The toolbar button Insert Image enables you to insert an image. By clicking
the respective icon button, the Object Selector window is called, enabling you to locate the
image name that you wish to reference by partial or full name.

• Inserting references:  You can insert a conref element to reference any element within or

outside your project scope by clicking the  icon at the button toolbar. This action calls the
Object Selector window from which you could search by string or browse for the resource you
wish to make reference to. Upon completing this action, the qualified conref is automatically
inserted where you have stopped the cursor.

• Refactoring:  Provides automated editing of topic elements and/or attributes, such as renaming,
splitting, joining, surrounding, or deleting an element. It also supports propagation of possible
consequences of the refactoring operation on references made to the subject element.
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• Tracking changes:  Editor can be switched into "tracking changes" mode and in this case it will
record any changes done in the Author mode (activated by using the Track changes button on
main tool bar of the editor). A number of tracking related functions are available: accept, reject,
and manage tracked changes.

5.2.3 Editing support views

In addition to the three available editor modes, DITAworks features a number of views that work in the
context of topic editor and change their content depending on their position in the document. These
views provide enhancements to the default editing features, as discussed in the following.

View name & illustration Description

Outline view

 

Displays the structure of the DITA XML file,
provides navigation support, and enables
adding or deleting elements using context
menu actions from within the view itself.
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View name & illustration Description

Elements view

 

Displays a list of valid elements that can be
inserted at the current cursor position

Properties view

 

Displays the list of possible attributes for
the current context element

 5.3 Validating topics
To perform topic validation, you are expected to be familiar with basic XML concepts, and in particular,
with the DITA content model.
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It is essential to ensure that topics are valid before you can publish them to any type of output format.
Validation takes place at two levels:

• Verifying that the XML DITA markup is well formed

• Verifying that the markup conforms to the appropriate DTD model of the subject topic

• Verifying link integrity (that they can be resolved to their file system locations)

Validation takes place in one of three ways:

• While editing

• At file save time

• By invoking the Validate menu option

• As you edit a topic document, an invalid element tag will get underlined in red and a red "x" mark
will appear as a line number overlay (to the left of the editor pane). Also, a small red box appears
to the right across fro the invalid element. You can identify the reason for invalidity by hovering
you mouse over either of these two markers. As you fix the issue while you edit, the red line and
the "x" mark (and the red box) will disappear, indicating that the document is currently valid. You
can also view the possible cause of an element tag invalidity by observing the warning or error
message(s)in the Console view.

 

• When you are done editing, you may wish to proactively validate your topic document, you can
do that in one of two ways:

• Right click your mouse at the subject topic file in the Project Explorer window and select
Validate

• Save the file at  File » Save . Saving a DITA file in DITAworks automatically trigger its
validation.

You may perform validation at the folder level, for all the topics it contains. You can do that by
right clicking the folder name at the Project Explorer view and selecting Validate. Validation
result will be presented via a pop up window.

While performing pro-active validation, pay attention to a small validation progress bar, whose
default location is at the status line at the bottom of the workbench.

As validation progresses, relevant statements appear in the console view indicating whether
there are errors and the nature of each error if any exists. When validation is successfully
completed, the validation progress bar will indicate 100% and then it will disappear.
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 5.4 Viewing rendered topics

While or after editing a topic, there is a need to view it in a page like environment, to visualize
the information flow and the content exact final presentation. Previewing topics provides valuable
feedback during the editing process.

You can (pre)view an individual topic at three levels of precision.

• First level:  Use the Author tab in the topic editor to see a fairly formatted topic view that takes
into account the demonstration of used elements.

• Second level:  Use the Preview tab to see the topic formatted as XHTML. This provides you a
more reader oriented view that does not consider the specific styling sheet to be used eventually
for map publishing. If you had already put together a map, you can perform a fast topic preview
by holding the Ctrl key and hovering your mouse over the topic reference within the map Text
mode.

• Third level:  If you wish to see the topic in the final way that will appear in the published map,
you may publish the individual topic. Doing this renders the topic to the presentation defined by
the respective model style sheet.

To publish an individual topic using your project model, follow the steps below.

• Highlight the topic by right clicking your mouse on its file name within the Project Explorer
window, and select one of the following options off the drop down menu:

• Use  Publish » Configure  if you will select an existing publishing configuration.

• Use  Publish » Publish To  if you intend to define a new publishing configuration. If you
used an existing configuration in this window, its name will be appended by an incrementing
number, as it will be considered a new configuration.

A Publishing configuration window will pop up, where you can select the output format to publish
the topic to or simply select an existing publishing configuration.

You can view the results of your publishing action by selecting  Publish » Last Results .
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Chapter 6
Developing DITA Maps
DITA maps enable authors to specify an overall document structure by arranging topic references in a
combination of sequence and hierarchy, as intended for publication to one of several possible output
format.

Maps provide semantics for linking across project topics as well as linking to external resources
(URLs). The development of a DITA map starts by creating a map file and populating it with a structure
of topic reference elements. Relationship tables can be appended to enable linking among related
resource topics.

Developing topic maps can range from a simple sequence of topic references to complex structures
involving a combination of sequences and hierarchies, possibly nesting maps within larger maps. To
create basic maps, you need to learn the procedures for creating, editing, and validating them. To
create more complex maps, you need to further learn about nesting maps, creating map links, and
creating relationship tables.

 6.1 Creating new maps
A DITA map is a DITA standard or custom infotype that you need to assign a name and a type, as
the case with DITA topics. DITA 1.1 standard supports two map types: the basic ditamap and its
derivative (specialization) bookmap. bookmap, which is intended for publishing longer book-like
documents.

1. You can create a new DITA map by invoking the map creation wizard, in one of the following
ways:

• At the menu bar, select  File » New » DITA MAP

• At the main toolbar (located at the top below the main menu, in the default layout); click the
New Map icon

• In the Project Explorer view, point your mouse to highlight the Maps folder, click your right
mouse button and select  New » DITA Map .

2. At the wizard's dialog window, assign a title to the map. The map file name will be derived from
the title according to the File Naming Conventions set in the Project Properties window.
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3. In the same window, select a map type out of the following choices (by highlighting and clicking
the respective thumbnail)

• map

• bookmap

• eclipsehelpcontexts

• eclipsehelpplugin

4. In the same window, select template for auto population of the new map out of the following
choices (by highlighting and clicking the respective thumbnail); and click Next

The following template types are available.

Map template Description of contents

Map Creates only the required XML and DOCTYPE declarations, as well as the root
map/bookmap element of the selected type (also called blank map)

Basic_Map In addition to the above, creates the <bookmeta>, the <frontmatter>, and
the <backmatter> element skeleton

Note: Available templates are part of the respective project model, to which the map being
created conforms. Other arbitrary templates can be created by the user as part of the model
project.

5. At the next dialog window, make a selection of the Map root element among the options
available in the drop down menu.

6. In the same window, make a selection of the Content options by checking the respective box;
and click Next

7. At the last dialog window, confirm the auto generated map file name; and click Finish
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The newly created map file will appear in the Editor area, with a tab showing the map file name. The
map file will also become visible in the Project Explorer view.

 6.2 Editing map content

A DITA map (the term is used herewith generically to indicate either ditamap, a bookmap, or another
map specialization, is an infotype specified to allow "mapping" topics into an output format with
meaningful information flow.

DITAworks supports map editing in one of two views: Source and Structure.

DITAworks also provides a Map Manager view of a similar structure and appearance to a file explorer
view. This view allows expanding and collapsing the map nested <topicref> elements

1. If the map file is not opened, you can open it in one of the following ways:

• In the Project Explorer view, double click the map file name, which you can find inside the
Maps folder.

• In the Map Manager view, double click the top item of the map hierarchy, which appears
with the name ditamap or bookmap

•
At the task bar, click the open resource icon . A window called Open Resource pops
up. Enter the characters you recall from the map name inside the field Select an item to
open. A set of resources, whose name contains the string you entered will appear in the
Matching items field. Double click the item that represents your map file name.

2. You can now start populating the map with elements. You can do that in one of two possible
views (represented by the tabs at the bottom left corner of the editing pane). The view that you
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choose for editing depends on personal preference, familiarity with DITA map markup (elements
and attributes) and the editing stage you are at.

• Use the Source editor, if you are familiar with DITA map elements, to better control fine
detail of the map content.

 

• Use the Structure editor to visually lay out the content order within your map. Use the
context menu to select your next editing action

• Append Child,

• Insert Before, or Insert After

• Move Up or Move Down

• Delete
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• Use the Map Manager view, if you wish to visualize the map structure in an expandable
collapsible folder-like structure. You have access to the operations available at the
Structure editor using the context menu of each map topic reference. An added benefit is
that you can open topic files referenced in your map, by double clicking their names. You
can also drag and drop topic references to modify their position within the map. This feature
makes the Map Manager view the most convenient way of navigating maps and modifying
their topic references.
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Editing a map from the Source view is no different than editing a topic file from the same view.
You need to be familiar with the map content model and take advantage of the drop down menu
support function while editing elements and/or element attributes.

3. Save your map file in the same way you save any other resource file.

 6.3 Creating relationship tables

Related links typically point to concept or reference topics that support current topic. A map
relationship table is a structured and systematic method of including "related links" within individual
topics. Rather than cross-referencing topics, a single manageable table in the map file can be
constructed to insert the related links within their respective topics, as specified.

The most basic relationship table consists of three columns. In a task oriented map, the center column
is dedicated for specifying task topics and the outer two columns are dedicated for specifying concept
and reference topics.

Each table row typically contain one task topic, to be linked to an arbitrary number of concept and
reference topics specified in their respective columns. It is possible to repeat outer column topics in
more than one row. It is possible, though not typical, to have multiple task topics in the center column,
and to have relations defined among them. In general, it is also possible to create a relationship with
arbitrary number of columns and topic arrangement, to support the specific use case.

Relation links render as hyperlinks. It is not typical to use a relationship tables for publishing to a PDF
document since the default DITA OT transformation does not support them. It is of course possible to
modify the transformation sheet to make relationship tables render as hyperlinks in PDF. An (X)HTML
based output remains the most typical use case for including relationship tables, due to its inherent
support for linking and navigating.

Follow the steps below to build a relationship table.

1. Add the <reltable> element, typically towards the end of the map file.

2. Populate the <reltable> element with a header using the <relheader> element and any number
of rows using the <relrow> element.

3. Populate the <relheader> element element with <relcolspec> elements, each of which will
indicate the topic type of its respective column.

4. Start populating rows using the <relcell> element, whereby each cell will contain one or
more topic reference. If there is more than one topic in a cell, you must group them using the
<topicgroup> element.

5. In a <relcell> element, use the <collection-type=family> attribute value to create relationships
among topics in the same cell.

6. Use the <linking> attribute to create one-way links between two cross-column topics. Use
<linking=sourceonly> to create a forward link and <linking=targetonly> to create a backward
link, with respect to the topic reference that contains the attribute.
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 6.4 Visually editing relationship tables

DITAworks Structure map editing mode enables you to visualize relationship tables and to add or
remove links via simple drag and drop actions.

1. To invoke the visual Relationship Table Editor, select  Window » Show View » Relationship
Table Editor , at the main menu bar. The editor will appear in an arbitrary view pane within the
workbench. You can drag it to the most suitable position depending on your current opened
views.

 

The viewer rows in the above image are sorted by left column entries, i.e. the first column
displays which task reference topics, each concept topic is linked to.

2. You can manipulate the content of a relationship table at the  Structure map editing mode; by
dragging and dropping the gray arrow icon from the source topic to the other topic you wish to
link to. While dragging, the arrowed line appears in a dotted red form. After settling at the target
topic, the line reduces to iconized blue arrows . The new link will be reflected in the Relationship
Table Editor view. If you wish to edit the link (e.g. delete it), you can highlight any of the two
linked topics, and as the link turns to a red color again, click the right mouse button and select
Delete from the context menu.
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 6.5 Validating maps
To perform map validation, you are expected to be familiar with the basic XML concepts, and in
particular, with the DITA content model.

It is essential to ensure that the topics are valid before you can publish them to any type of output
format. Validation takes place at two levels:

• Verifying that the XML DITA markup is well formed

• Verifying that the markup conforms to the appropriate DTD model of the subject topic

• Verifying link integrity (that they can be resolved to their file system locations)

Validation takes place in one of three ways:

• While editing

• At file save time

• By invoking the Validate menu option

• As you edit a map document, an invalid element tag will get underlined in red. You can identify
the reason for invalidity by observing the warning or error message(s) in the Console view.

Note that the map source editor is not based on <oXygen>® editor, and that it does not feature
the same visual validation aids as within the topic Source editing view.

• When you are done editing, you may wish to proactively validate your map document. You can
do that in one of two ways:

• Right click your mouse at the subject topic file in the Project Explorer window and select
Validate .

• Save the file at  File » Save . Saving a DITA file in DITAworks automatically trigger its
validation.

If you have a folder containing multiple maps, you may perform validation at the folder level, all
at once for all maps it contains. You can do that by right clicking the folder name at the Project
Explorer view and selecting Validate. Validation result will be presented via a pop up window.

While validating the map file, pay attention to a small validation progress bar, whose default
location is at the status line at the bottom of the workbench.

As validation progresses, relevant statements appear in the Console view indicating whether
there are any errors and the nature of error(s) if any exists. When validation is successfully
completed, the validation progress bar will indicate 100% and then it will disappear.
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Chapter 7
Reusing Content
The DITA authoring architecture was designed around the principle of authoring specific and
minimalist topics that contain elements with clear content purpose. One of the motivations for the
structured authoring approach is to enable reusing pieces of content across an arbitrarily large,
dynamically growing, sets of documents.

Content reuse can take place at different levels of granularity:

• Reusing a string of characters using the general XML entity notation, by direct reference

• Reusing blocks of text, regardless of their containment (within or without) DITA element, by using
wrapper elements tags

• Reusing whole elements within their valid context inside a topic, by referencing the element ID

• Reusing topics in more than one map, which is the most intuitive and common type of re-use, by
referencing the topic file

• Reusing a smaller map (component or chapter), that is nested within another, in more than one
map

• Reusing the same primary map to publish to several media/channels by applying proper style
sheets

It is up to the information developer to plan and take best advantage of content reuse.

Reuse of content may be unconditional (by direct, topic, or content reference) or conditional.
Unconditional reuse means that the referenced content will always be part of the output for the same
transformation scenario. Conditional reuse (referred to as conditional processing) is a dynamic
process that includes or excludes one of multiple pieces of content depending on an attribute, whose
value is examined at the publish time. For example, different editions of a book or a software manual
may contain different components of content, and that edition value is provided at the publish time to
include the proper components in the output publication accordingly.

DITAworks provide several visual tools to support reusing content at different levels of granularity:

• A special Reuse view, where you can define reusable variables, text blocks, and text templates

• An Object Selector function to support making conrefs (content references) in a topic or map
editor

• A map Structure editing mode and a dedicated Map Manager view to support making
topicrefs (topic references) within a map file

The screen below shows an instance of a project's Reuse view, which you can invoke through the
main menu option  Window » Show View » Reuse
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 7.1 Defining and reusing variables

DITAworks variables are short text strings used to substitute a lengthier or more bulky strings of
characters. The basic concept draws on XML general entities, which enable reference to certain
unallowable (non XML) names or special characters using a specific notation. However, variables
in DITAworks are not limited to the general entities concept and can be used for direct substitutions,
although referencing the variables still follow the same notation.

A DITAworks variable must be a valid XML name, i.e. an alphanumeric name that may contain only the
special characters: hyphen (-), underscore (_), or period (.).

A DITAworks variable can be referenced for substitution by its pre-defined value using the following
notation: the variable var is preceded by an ampersand (&) and followed by a semicolon (;), so it is
referenced as &var;

Variables are defined and maintained in a list that is accessible within the Reuse view.

1. To define a new variable, invoke the Reuse view from the main menu  Window » Show View »
Reuse .

2. Click the plus sign (+) icon to add a new table entry.

3. Enter the variable name and its assigned value. See examples below.
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• The variable copyright is assigned the value '&#169;', which is the Latin-1 encoding of
the copyright special character (©). To reference this variable, use '&copyright;'.

• The variable double-amp is meant to reference a string of two successive ampersand
characters (&&). Instead of having to type '&amp;&amp;', you can refer to it as
'&double-amp;' in any DITA document within the project scope.

• The variable gt is used to substitute the greater than (>) character. It can be referenced in
any DITA document as &gt;

Note: One further benefit of Reuse view variables, is that they could be defined at publish time
from the Publishing configurations window, by clicking the Advanced hyperlink, and selecting
the Variables tab.

 7.2 Defining and reusing text templates

Text templates are chunks of text that have arbitrary length, and may contain (or be contained
within) DITA element tags. Reusing text in this manner is not a standard DITA feature but rather a
technique adopted by DITAworks, The objective was to simply enable highlighting any block of content
regardless of what's in it, treat the whole block as plain text, and assign it a shorthand name to be re-
inserted at the cursor position in any DITA document by clicking its name within the Reuse view.

1. To affect a text template reuse, highlight the text within the editor's Text mode, and at the context
menu, select Add block to reuse...
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2. A window called Create new template is invoked, with the selected text block in view. Assign a
name to the reusable text block in the Name field and check the template radio button.
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3. Assign a name to the text block and check the radio button template, and click OK. The text
module is added to the Reuse view.

4. To insert the text template in a DITA topic file, stand your cursor at the position where you wish to
make the reference, and double click the variable name (or drag it) at the Reuse view. The text
will be directly pasted at your selected position.

It is the user's responsibility to ensure the validity of the inserted text within the target DITA
document.

 7.3 Reusing elements (text blocks)

DITAworks text blocks are valid DITA elements that may contain other elements within them. A text
block can be added to the Reuse view for later use by a DITA document via conref. This is the
standard DITA element reuse mechanism. The Reuse view provides a project scope storage for
reusable elements, where each can be referenced for proper inclusion in the DITA document at the
cursor place, by making a conref. If an element's ID is changed, DITAworks updates the reference in
the Reuse view. It is the user's concern to ensure the validity of the element being referenced, where
the reference is made.

1. To add a text block (reusable) element to the Reuse view, call the Create Variables window in
one of the two following ways:

• Open the Editor context menu (in either Text or Author modes), and select Add block to
reuse...; or

• Open the Reuse view at the main menu option  Window » Show View » Reuse , and
click the Add (the '+' sign) icon.
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2. Select the radio button text module, and assign a name to the reusable block (element content).

Note: You are assigning the variable name that will be used to locate the text module at the
Reuse view. This is not the reusable DITA element name. Using the procedure herewith, you will
not need to recall the element ID and the conref syntax, since you will drag the element into the
document that needs to reference it, by its variable name, from the Reuse view.

3. To identify the reusable block, click Browse to call the Object selector window, where you can
enter part of the name of the topic file that contains the element block you wish to reuse. You will
be presented with a list of all DITA documents that contain the entered string. Each file name can
be expanded to show all its constituent elements. Select the target element, and click OK.

4. Now that you had defined both the variable and the value, in the Create Variables window, click
OK to create the Reuse view entry.

5. To make reference to the subject element in a DITA topic file, stand your cursor at the position
where you wish to make the reference, and double click the variable name (or drag it) at the
Reuse view. An equivalent element with the proper conref attribute syntax will be constructed
and inserted by DITAworks.

 7.4 Reusing topics

Topic reuse is the most commonly inherent reuse mechanism intended by the DITA architecture. The
DITA architecture constructs documentation components via maps that contain topics by reference
(typically using the topicref element).

In this respect, DITAworks provide support for constructing maps out of topic references through its
Structure map editing mode and its Map Manager  view. Features include, appending topics at the
same or a child level, locating topics, and moving topics within the map structure by simple drag and
drop operation. Another powerful support tool is the Object selector, which enables you to search
topics, among other resources, by a string that is part of the resource name.

 7.5 Reusing maps

The main case for reusing maps is when a map stands out as a recognizable document component.
In this case, the component may be made available for use by several larger maps targeting different
document sets (for e.g. for different audience) or being funneled to several output channels (formats).
This situation is called map nesting.

Maps are inserted within larger maps using the same topicref element, used for referencing topics,
with the format attribute set to map or bookmap and the type attribute set to topic.

The Structure map editing mode and the Map Manager view provide the same type of support to
making references to maps from within larger maps, with the exception that the nested (or reused)
map title will not appear at the node representing box (or icon).
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 7.6 Conditional processing

Conditional processing involves filtering or flagging content based on processing-time criteria; such
as target audience, platform, product or other user-defined criteria. Each criterion may assume one
of a number of possible values. Processing proceeds "conditionally" depending on the value of the
involved criterion.

You can use metadata on elements to filter or flag content, and to show revised content. You can use
attributes to provide information about what product, audience, or platform an element applies to, or
what revision it belongs to.

You can exclude or flag your content, and show its revision information, based on its metadata. By
default, all content is included, no content is flagged, and all revision information is hidden.

Assume that you have a need for two versions of your installation instructions, one for Windows and
another for Linux. You can create a topic file with both sets of instructions (with each set properly
labeled as either Windows or Linux), and then use a Conditional Profile to specify your processing
rules (for example, whether to produce a Windows or Linux version of the document, or whether to
produce a single output file with the content flagged appropriately with Windows and Linux icons).
The criterion here would be the platform attribute and its set of possible values: {Windows, Linux};
whereby processing proceeds depending on the assigned value.

Tagging

The term "tagging" is used in the context of conditional processing to indicate the definition and usage
of criteria in the manner explained above.

DITAworks provides a central registry for Conditional Processing tags that can be used in one or more
projects. This registry is presented to the user in Tags View, illustrated below. To open the tags view,
select  Window » Show View » Tags .

In the Tags view, which is meant to simplify the tagging process, the user can perform the following:

• Tag content in the editor view

• Define new tag groups and their allowed tags values

• Manage tags within existing tag groups

• Search for usages of separate tags or tag groups in projects
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Standard DITA tags

Standard DITA tag groups (attributes) are defined in DITAworks central tags repository and visible in
the Tags view. These attributes are meant to be used for conditional processing. They include:

• audience: Indicates the intended audience for the element

• platform: Indicates operating system and hardware

• product: Contains the name of the product to which the topic applies

• rev: Indicates revision level of an element

All user defined Conditional Processing tag groups will be mapped by DITAworks to the otherprops
DITA attribute.

Tagging example

The example below demonstrates how to use the DITAworks tagging functionality.

1. Open one of the DITA topics using topic editor and go to the source view.

2. Highlight one of the XML elements you would like to tag, by placing your mouse over it, and
double-click the subject tag in the Tags view. Alternatively, you can drag & drop tags from the
Tags view to the XML element.

3. The XML element will be appropriately tagged.

4. By selecting tag in the Tags view, the editor will highlight all occurrences of this tag in the
document.

5. Now try to provide an invalid value to the attribute platform: change it to platform="macos" and
save.

6. Note that you immediately get an error reported in the editor view as well as in Problems view
reporting an invalid tag value.
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Chapter 8
Publishing DITA Maps
The basic DITA map publishing process is performed using the built-in features of the standard
DITA Open Toolkit (version 1.5). The tool employs open source Java processors to accomplish two
necessary steps on the source map file (which in turn contains references to all included topics):

1. Transformation: Accomplished using XSLT (XML Style Sheet for Transformation), which contains
precise declarations informing the processor of how to transform each DITA element into a
presentable element or object for display. In some cases, like when generating PDF, there is
an intermediary stage that comprises transforming the DITA XML into XSL-FO (Formatting
Objects)that specify the presentation of the final document. In other cases, like when generating
XHTML for rendering by a browser, DITA XML elements are transformed directly to XHTML tags
and styling is achieved separately by means of CSS (Cascading Style Sheets).

2. Styling: Accomplished using a style sheet that defines the precise final presentation of each
element to the selected output form. Generally, there two main final styling languages: one for
generating PDF documents (the generated FO file) and another for producing XHTML based
documents (the separate CSS file). Most Help Pages content is based on XHTML due to its
inherent support for manageable hyper-linking.

DITAworks users can choose to run publish using the basic DITA OT built-in transformation scenarios
and style sheets, using the DITAworks developed Eclipse Help style sheets, or develop/customize
their own. Developing own style sheets is part of the DITAworks modeling functionalities and is beyond
the scope of this Guide (see the "DITAworks Guide for Information Architects").

Publishing valid DITA maps with DITAworks is comprised of two steps:

1. Configuring the publishing properties; and

2. Commanding DITAworks to start publishing (running the publish process)

 8.1 Running the publish process

To run the publish process for a standard DITA OT configuration, or a custom configuration that had
been prepared in DITAworks, follow these steps:

1. Invoke the Publishing configurations window, from either the main task bar Publish icon, or
from the map file context menu:  Publish » Configure .

a. Select the publishing configuration name from the menu at the left side of the window.

b. Verify (or modify as may be needed) the publishing configuration properties: Name (of
configuration profile), Input file (name and location of source map file), Type (of output),
and To (file system target location of output file).
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2. When ready, click the Publish button. When publishing starts, the process progress can be
followed at the right side of the status line, and by following the Console view messages.

 

3. When publishing is complete, note the pop up window Publishing finished. There may or may
not be warnings and/or errors generated while processing, in the Console view.

Warnings would not prohibit the output document generation. Also, some errors will not stop the
process from generating an output. In both cases, you must investigate them and work to resolve
them. All steps of processing sequentially appear in the Console view. In addition, and for user's
convenience, a hyperlink to the full log file is available and will open up a log tab in the editor
area.

In case the processing produced one or more errors, the output may or may not be viewable. If it
is, the Publishing finish will display a View output button in addition to the View errors button.
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If the processing completed without any errors the View errors button will be greyed out. You
can also find the warning and error messages at the Console view, which provides a link to a
consolidated "publishing.log" file that you can open in the Editor pane and save for reference
and analysis.

 8.2 Supported output types

DITAworks publish maps to some output types that are directly supported by DITA OT and some other
types, whose transformation and styling infrastructure was developed by DITAworks.

Standard OT output types

Output Type Description / Comments
PDF Portable Document Format (Adobe): Used to generate linear read-only documents

for print and screen display; and is the most commonly accepted form for the
exchange of formal documents

XHTML eXtensible HyperText Markup Language (W3C): The XML version of HTML; and
the most commonly accepted format for online publishing at this time

HTML Help The most basic and common form of HTML based Help Pages, featuring
hyperlinks, and composed of individual HTML files

Java Help One of several forms of help pages, most popular alongside Java development
environments

DocBook An XML-based OASIS standard; and the most commonly accepted format for
publishing "linear" large XML based (sets of) books, currently being debated as to
its pros and cons with respect to DITA

SCORM Sharable Content Object Reference Model (Rustici Software): A proprietary
standard for publishing e-learning software

Troff An old UNIX format for publishing documents

RTF Rich Text Format: The simplest form of enhanced plain text format, allowing control
over basic editing features such as selective font face, type, color, etc.

DITAworks Output Type (added value)

DITAworks provides in-house developed models to support generating sophisticated help pages for
Eclipse applications.

Output Type Description / Comments
Eclipse Help A format that can be used as a plugin with any Eclipse developed application, to

make up its Help pages, based on a DITAworks bookmap specialization

Eclipse Help with
Contexts

A special feature that enables tight coordination between Eclipse software
development and documentation teams to display help based on programming
context and to enable help assisted programming tasks

Active Help An Eclipse feature that enables calling Eclipse code from the help plugin or the
online help pages
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 8.3 Defining publishing configurations

A publishing configuration consists of a number of properties representing the source topic or map file
to be published, the destination folder of the output file, the output type, and other advanced options
that are explained in the Create new configuration window below description below.

1. To define a map publishing configuration, invoking the Create new configuration window from
the task bar icon menu  Publish » Publish To  , or from the map file context menu.

 

2. Fill in the required fields and make the necessary selections, as follows:

a. Name: Refers to the publishing configuration profile name. It can be manually assigned or
automatically generated.

b. Input file: Name of topic or map file to be published.

c. Type: Refers to the output type. Choice is made, out of available models, through a drop
down menu.

d. To: Refers to the folder where the published output file shall be stored, which may be
the default location as determined at Content Project creation time or any other arbitrary
location within or outside the workspace.

e. Clear output folder: Check mark this box if you wish to delete all output files generated
from previous publication attempts.

f. Profile: Refers to the selection, through a drop down menu, of an available conditional

processing profiles. A new profile can be defined at this stage by clicking the  button.

g. Resolve Links: Check mark this box if you want the publishing engine to validate links
before transformation. The engine will also check for links that may have gone out of scope
of current map.
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h. Advanced hyperlink: Click this link to invoke a wizard that provides further configuration
controls via three tabs. The Variables tab provides the list of variables defined in the Tags
view, allowing the addition or deletion of some variables for the subject configuration profile.
The Parameters tab provides a list of available publishing runtime parameters. The Link
resolution tab displays all stored user decisions about links that point outside of map
content. So, it lists all detected external references and stores what actions should be taken
to resolve them.

8.3.1 Defining variables for publishing

Publishing variables are similar to XML general entities where a variable can be later used in a topic to
refer to its defined value.

1. Publishing variables can be defined at the task bar, or the map file context menu, by selecting 
Publish » Configure » Advanced  to invoke the Properties window.

2. To define a variable, select the Variables tab, enter the variable name and its corresponding
value in a new table row. You can enter as many variables as you wish as you develop your
content project. When you want to save the currently entered variables, click OK.

To refer to variable var in a topic file, use the XML general entity convention &var;, which will
be substituted by the variables entered value.

 

8.3.2 Defining parameters for publishing

Publishing parameters are run time parameters used by the DITA Open Toolkit, which runs the scripts
necessary to complete the processing steps for publishing.
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The Variables page provides the way to redefine variable from Reuse module. You can redefine any
variable and new value will be used only for configured publishing.

The Parameters page gives a possibility to provide more parameters to Open Toolkit.

The Links resolving page adjusts parameters of link resolution.

After setting the transformation configuration, the configured profile can be saved using Save button.

8.3.3 Resolving links out of map scope

An out-of-scope link is a reference within a topic to another topic that is not referenced in the context
map, i.e. the map (or maps) containing the referring topic. It is out of map scope because the map
is not setup to publish the "resource" referenced link. It is then considered a broken link, somewhat
similar to an external HTTP resource reference that is no longer available at the designated URL.

The most common way to resolve links at publishing time is to checkmark the Resolve links box at
the  Publish » Configure  or the  Publish » Publish To  windows.

8.3.4 Configuring conditional processing profiles

Conditional profiles simplify the customization of conditional processing parameters. They actually
contain similar information to that in the ditaval file as used by DITA Open Toolkit.

Using conditional profiles, content tagged with the Tags view can be filtered out in certain publications.

A conditional profile variable is also dubbed the name tag (this is not to be confused with the HTML
terminology that used the name "tag" to indicate an element, which is also occasionally used to
indicate an XML or a DITA element).

DITA Open toolkit defines a number of standard tags. These are:

• audience

• platform

• product

• rev

1. To define conditional processing profiles, open the Create new configuration window by
selecting  Publish » Publish To

2.
At the Profile field, click the  button

3. Click the add icon to enter a new profile.
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Chapter 9
Version Control
The version control functionality enables a collaborating team to synchronize individual changes and
to track different revisions of content. The main operations with version control include updating,
committing, and synchronizing project resource versions. Besides basic revision tracking, most of
the version control systems also enable tracking parallel versions of the same documents, a function
known as branching, which is an advanced topic that is of the scope for this document.

DITAworks enables integration with any version control system that has an Eclipse plug-in and comes
with out-of-the-box support for either of the following version control systems:

• Concurrent Versions System (CVS); or

• Subversion (SVN)

Other repositories can be supported using third-party plug-ins.

DITAworks offers support for team work operations directly from the workspace. This support allows a
team member to concurrently interact with version repository. Resources within the workspace allow
team members to deal with version and configuration management issues.

Most version Control systems introduce the notion of a "working copy," which is a set of files that can
be checked out from version repository and modified locally. All changes are done on the working
copy. After work is finished changes can be committed back to version repository file by file, folder by
folder, or all at once.

The screen below shows the context Team menu (on example of CVS version control system) used
for project collaboration, with the options including: Update, Commit, Synchronize with Repository,
Revert to base, etc.

The most prevalent Team menu options are elaborated in the following sections (using the CVS
Version Control system as a case example).
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 9.1 Updating project

Update operation is used to get latest changes from version repository locally to your working copy.
This operation should be performed regularly to get latest version of content or prior to a commit [page
77] operation.

To update a project, a project folder, or a resource file, from a Version Control repository, highlight
the subject object in the Project Explorer view and select  Team » Update  at the respective context
menu.

You can follow the progress and success of the update process at the resulting pop up window.

After successfully updating project all changes from Version Control repository will be applied to the
local version of the project(working copy). Changes from version repository will be merged to your
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working copy. In case changes from version repository are done in the same line as local changes
conflicts can occur. You can check results of Update operation in appropriate console.

 9.2 Committing changes
Commit operation is used to bring your local changes to version repository. In most of the cases it
requires Update operation to be performed in front and all possible conflicts to be manually resolved.

To commit a project, a project folder, or a resource file, to the Version Control repository, highlight the
subject object in the Project Explorer view and select  Team » Commit  at the respective context
menu.

Window will appear listing all changes made locally: files that had been modified, newly created, or
removed. You can omit any files from that list if you do not want to commit their changes to the Version
Control repository.

To remove a resource from the list to be committed, highlight the item(s) with your right mouse button
and select Remove.

You can check content changes by using Text Compare View (double-click on the file on the Changes
area).

When ready, click Finish to upload the resources you chose to commit, to the Version Control
repository.

Modified and new files are shown in the Project Explorer view with the special shaded mark ">" and
new files have no version information. You can remove any files from that list if you do not want to
commit changes to Version Control repository (use Remove from view action from right-click menu).
Additionally you can check content changes by using Text Compare View (double-click on the file on
the Changes area). And finally press on the Finish button to commit changes to the Version Control
repository.

Note: Modified and new files are shown in the Project Explorer view with special mark (“>”) and new
files have no version information.

 9.3 Viewing history

Projects that are managed by Version Control have their file local history and remote history appear
together in the same view. To view the consolidated history for a shared file in the History View,
perform the following steps:

1. Select a file that is contained in a project.

2. Right-click the file in order to access one of the following history related options:

• Team » Show History... , which opens the History View with the revisions of the selected
file displayed in the table

• Compare with » History... , which opens the History view with the revisions of the
selected file displayed in the table

• Replace with » History... , which does the same as the comparison operation
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3. The History view will open and display the revisions available for the selected file. You can
control what type of revisions are shown in the table by selecting the appropriate toggle button in
the History View toolbar.

• Local and Remote Revisions,

• Local Revisions, or

• Remote Revisions

The following operations are available when right-clicking the entries in the History view:

• Open: opens the selected revision

• Compare Current with Revision: compares the selected file with the current revision of the
file that resides in the workspace

• Compare with Each Other: compares two selected revisions

• Get Contents: replaces the current workspace file with the contents of the selected revision

 9.4 Reverting changes
Revert operation is used to revert local changes to the state of your last Update operation.

To revert changes use Revert to Base action from the right-click context menu. This can be applied at
project, folder, or resource file levels.

 9.5 Synchronizing views

You can synchronize a project with Version Control repository by using the Synchronize view. A
project synchronization launched using the  Team » Synchronize  with repository context menu. This
view allows you to inspect the differences between the local files and their remote counterparts as well
as update files and commit local files to a repository.

The Synchronize view shows the synchronization state of files in your workspace compared to those
in the repository. This state is shown by using icons and can also be configured to show the state as
text appended to the resource name.

The Synchronize view can be filtered using modes from either the toolbar actions or the menu items
in the view's drop down menu. Modes can be used to show only incoming, outgoing or conflicting
changes.

It is preferable to update resources in the project first, resolve any conflicts that exist by merging and
then commit local files to the repository.

When dealing with conflicts, you can first perform an update and detect any conflicting changes. The
update operation will correctly update files that are auto mergeable (i.e. files content changes do
not overlap). Files that have overlapping changes, will be reported in status of Conflict. Alternatively,
conflicts can be handled using a Compare editor. A Compare editor can be opened by double-clicking
on the conflict or by choosing Open in Compare Editor from the context menu. The Compare editor
allows you to manually resolve the conflicts in the file. Once completed, perform a Mark as Merged on
the conflict to indicate that you are done. This will change the conflict into an outgoing change.
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Chapter 10
Developing Eclipse Help
The Eclipse Platform includes its own help system based on an XML table of contents that references
XHTML files. This is a standard way to document Eclipse-based software applications. Eclipse Help
format is not restricted only to applications developed using the Eclipse IDE. It can be generated for
use with a standalone server solution for online help delivery. The Eclipse Help conventions provide
advanced desirable navigational features such as ToCs, search, indexing, bookmarking, etc.

When Eclipse help is used for documentation of Eclipse-based software, there are significant
added values. Help pages are easily integrated with the application as a plugin component. More
sophisticated mechanisms for interaction between the application and its associated help pages are
enabled. For example, the deployment of context-dependent help enables the software developer to
seek help that is specific to the current programming context. Furthermore, active help provides the
ability to invoke Eclipse code from the plugin or online help pages.

DITA Open Toolkit provides only limited ways to transform DITA maps and topics into Eclipse help
plugins. To be more precise, DITA OT will generate a TOC file and set of XHTML topics linked to the
source map. There are, however, several limitations of the generic OT transformation scenario that
are thoroughly addressed by DITAworks to utilize the full capability of the Eclipse help system. These
include:

• Interlinking topics across several Eclipse help plugins

• Tuning of plug-in contents (Manifest properties, amount of ToCs, indexes, contexts, etc.)

• Definition of search phrases

• Definition of contexts (for context-dependent help)

• Support of dynamic context ID mapping (DTP approach)

• Integration of cheat sheets

• Implementation of active help for code generation

• Tools for integration with development process. (Context IDs management between development
and documentation teams)

• Plug-in for Eclipse IDE

• ID synchronization wizards

 10.1 Eclipse Help specializations

New Eclipse Help DITA model (specialization) has been created in DITAworks, to fully support the
semantics and data structures necessary for taking full advantage of Eclipse Help features. The
Eclipse Help model defines the following DITA specializations.

• eclipsehelpplugin: a structural specialization of DITA map (map) that covers the specifics of
Eclipse help plugin descriptors
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• eclipsecontexts: a structural specialization of DITA map used to model context sensitive
help contexts

• liveAction: a domain specialization, whose purpose is to support assisted code generation
from within Eclipse Help

DITAworks Eclipse help Model also defines:

• Transformations for Eclipse Help specific infotypes

• A set of visualization settings for map editor, preview templates, content validation rules, etc.

• Eclipse Help project template to help the user get started

 10.2 Creating Eclipse Help Content Projects

Creating an Eclipse Help content project is basically similar to creating a standard DITA Content
project, except that a special project template must to be selected.

1. At the main tool bar, select  File » New » DITA Content Project .

2. At the New DITA Content Project window, enter a project name in the Project name field, then
click Next.

3. Select the project template Eclipse Help Plugin and the modeling project Eclipse Help, by
highlighting the respective thumbnails; then click Finish

The newly created content project with predefined folder structure of Eclipse Help maps will appear in
the Project Explorer view.

 10.3 Developing Eclipse help plugin maps

Eclipse help plugin maps are a specialization of the standard bookmap element. These maps can be
published to an executable Eclipse Help file (similar to the CHM single-file executable of HTML Help)
or can be integrated into an Eclipse based application as its native Help Pages.

1. To create a new Eclipse Help plugin map, select  File » New » DITA Map , to open the New Map
window.

2. Select the document type eclipsehelpplugin, by highlighting it, and assign a title to the map
being created; and Click Next.

3. Verify the automatically created map file name, and select the folder where you wish to store the
map file.

4. You can start populating the newly created map in either the Structure or the Source view (an
example structure view illustrated below).

The Eclipse Help Plugin Map provides possibility to define the following:

• Properties of Plugin Manifest. Different elements under info element.

• Reference to one or more tables of content (DITA maps), using the tocfile element's href
attribute that points to a map or to a map specialization. You can define several ToCs for the
same plugin, but you must nominate one of them as primary by setting the respective type
attribute.
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• Reference to one or more context files, which are described using eclipsecontexts DITA
map, using the contextsfile element's href attribute that points to a map or to a map
specialization.

• Reference to one or more cheat sheet files.
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 10.4 Developing Eclipse Help contexts

Context sensitive help is a feature of Eclipse platform that enables display of a focused set of help
topics related to the current user interface context inside of Eclipse application. This form of user
assistance is delivered to users when a platform-specific key-trigger is activated (for e.g., the F1 key in
Windows).

Context-sensitive help is described by associating the so called context id declared in the UI code
with a help description and list of links to related topics or commands in the online help. In the target
Eclipse Help format, these associations are made inside a special XML file (context file) located
within the help plug-in that contains the topics in question. You can create any number of XML files
containing context help associations for each plug-in. The description and links for each context id
are made inside the context elements in the XML file. Each context element can contain an optional
description element that is used to describe the UI object. It can also contain any number of
topic elements, which provide links to the online documentation as well as command links to perform
several user operations (e.g. open a cheat sheet).

DITAworks offers the specialized infotype eclipsehelpcontexts to enable the definition of Eclipse
Help contexts in DITA. The structure of this infotype is similar to that of Eclipse Help context file,
except for the restricted use of some attributes. Note that one eclipsecontexts DITA map can
contain definitions of many help contexts. Each context defines description and set of topics that form
the associated help context.

To create a new Eclipse Help contexts map, follow the below steps.

1. select  File » New » DITA Map , to open the New Map window.

2. Select the document type eclipsehelpcontexts, by highlighting it, and assign a title to the
map being created; and Click Next.

3. Verify the automatically created map file name, and select the folder where you wish to store the
map file.

4. You can start populating the newly created map in either the Structure or the Source view.

 10.5 Developing Active Help

Active help is about the ability to invoke Eclipse code from online documentation. Originally in Eclipse
Help System it is implemented by including JavaScript in the online documentation HTML that
describes a class to be instantiated within the Eclipse platform.

For example, instead of writing, "Go to the Window Menu and open the message dialog," your online/
context help can include a link that will open your application's message dialog for the user. Active
help links look like hyperlinks in the online help.

In DITAworks, Active Help is supported by introduction of new domain elements that describe
active help actions using DITA. Example of such element is liveAction element. Live actions are
references from help content to certain dynamic actions or commands in Eclipse Application.
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To be able to reference such action or command, it should be defined in Eclipse application first.
You can learn more about how to accomplish this at http://help.eclipse.org/stable/index.jsp?topic=/
org.eclipse.platform.doc.isv/guide/ ua_help_content_active_action.htm.

In a DITA Content Project, Live Actions can be defined as follows:

1. Open one of the topics using DITA Topic editor in Author mode.

2. Select the text you would like to make as live Action.

3. Right click the highlighted text. At the drop down menu, select  Refactoring » Surround with
tags , to invoke the Specify the tag window.

4. select the liveAction element from the list.

5. Set the attributes for the newly created element as per the liveActions specialization
reference content model.

6. The Live Action defined in this way will be transformed into a valid live action call upon
transformation to Eclipse Help. In other formats this element will be processed as a regular ph
element.

To be able to use specialized Eclipse Help domain elements (like liveAction), your content
project should depend on the Eclipse Help Model. In case you have custom infotypes, they
should include the activehelp domain.

Following is an example of using the liveaction element

 <p>Set attributes for newly 
  <liveAction
 laclassName="org.eclipse.platform.doc.isv.activeHelp.ActiveHelpOpenDialogAction"
 laplugin="org.eclipse.platform.doc.isv" 
  >created </liveAction> element. </p>

 10.6 Including cheat sheets

The Eclipse platform introduces several mechanisms to help users choose what task needs to be
done and guide them through the steps in that task. These mechanisms are used by the Eclipse
workbench itself.

• Some steps can be performed by the cheat sheet and some others are described to the user for
manual implementation

• Composite cheat sheets can guide the user through larger coding problems by breaking down
that problem into several tasks, each represented by a simple cheat sheet.

Cheat sheets are defined in XML files based on a special DTD and the visual editor in Eclipse. You
can get more information about defining cheat sheets at http://help.eclipse.org/stable/index.jsp?topic=/
org.eclipse.platform.doc.isv/guide/ua_help_content_active_action.htm

DITAworks enables the user to edit cheat sheets using a standard Eclipse built-in cheat sheet editor.
Once cheat sheets are defined in separate XML files, they can be linked to an Eclipse Help Plugin
Map, as follows:

1. Open one of the Eclipse Help plugin maps in the map editor.

2. Insert a cheatsheets element within the eclipsehelp element, if it does not exist already.

3. Add one or more links to cheat sheets using the contentFile attribute of cheatsheet element.

http://help.eclipse.org/stable/index.jsp?topic=/org.eclipse.platform.doc.isv/guide/                     ua_help_content_active_action.htm
http://help.eclipse.org/stable/index.jsp?topic=/org.eclipse.platform.doc.isv/guide/                     ua_help_content_active_action.htm
http://help.eclipse.org/stable/index.jsp?topic=/org.eclipse.platform.doc.isv/guide/ua_help_content_active_action.htm
http://help.eclipse.org/stable/index.jsp?topic=/org.eclipse.platform.doc.isv/guide/ua_help_content_active_action.htm
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 10.7 Managing cross plugin links

Eclipse platform enables the developer to build component-based solutions, requiring in turn
component-based documentation. This situation forces the documentation architect to split all content
into several Eclipse Help plugins that can be deployed independently. The split introduces a new
problem related to links between topics that should be published to different plugins.

Suppose we have two DITA topics: A and B. We also have defined two Eclipse Help plugins: pluginA
and pluginB. Topic A is included in pluginA and topic B is included into pluginB. Now we can publish
pluginA and pluginB and get two independent Eclipse plugins with help content.

Everything works well until we get a situation when Topic A references Topic B (e.g. using the xref
element). While initiating the publishing process; the link from topic A has to be defined using an
absolute path that includes the ID of the plugin, where topic B resides, and the proper path to it. This
path can not be generated without knowing the target plugin name of topic B.

To address the above described problem, DITAworks introduces the notion of publishing context.
Publishing context defines rules for resolving external links during the publishing process, which can
be assigned to one or more Publishing configurations.

When publishing starts, DITAworks checks the availability of external links, i.e. references to topics
not included in the current publication. In case such references are detected, DITAworks displays a
dialog asking the user to select publishing context, as well as maps to be used for resolving external
references. When the user resolves external links, this information is stored in publishing context and
publishing process can go on.

 10.8 Publishing Eclipse Help

Eclipse Help DITA Model defines special publishing types to generate Eclipse Help plugins out of
eclipsehelpplugin and eclipsecontexts infotypes.

Follow the procedure described below to define publishing profiles for an eclipsehelpplugin map:

1. At the Project Explorer view, select the eclipsehelpplugin map you wish to publish.

2. Right click the highlighted map file to invoke the context menu and select  Publish »
Configure... .

3. At the Publishing Configurations window, click the New publishing configuration button.

4. Fill all publishing configuration parameters and be sure to select the publishing type as "Eclipse
help with contexts."

5. Save your newly created publishing configuration.

6. To publish your eclipsecontexts map, select  Publish » [name of your publishing
configuration] .
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 10.9 Integrating Eclipse Help with Eclipse applications

Development of Eclipse Help may target either online XHTML help pages or help pages to be
integrated with an Eclipse application. Integrating Eclipse Help within an Eclipse application takes
advantage of the three DITAworks specializations: exlipsehelpplugin, eclipsecontexts,
liveActions.

The procedure for such integration involves actions to be performed at the Eclipse development
platform itself, to prepare the development environment for being receptive to the fore mentioned
specialization contents. For more information about integrating with Eclipse applications, consult the
"DITAworks Guide for Eclipse Developers."
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User Interface Menus
Menus are provided in three different forms:

• Main menu bar: The main resource for finding a covering set of menu options, classified by menu
name

• Context menus: Invoked by clicking the right mouse button within a view or editor area, or an
object within a view (e.g. a folder or a resource file)

• Task bar menus: certain icons can be dragged and placed at the main task bar, or at other user
interface locations, such as the status line. These menus are shortcut icons to menu options that
are available elsewhere. They are meant to enable the user to customize the work environment
to best match their working habits. All such options are available either within the main menu bar
or the context menus.

 The Menu Bar

The menu bar is located at the top of DITAworks user interface. Its position cannot be changed, as
may be the case with some other interface components. The list of featured menus slightly varies
depending on the resource being edited. In particular, when editing a DITA map as recognized by a
highlighted map tab, the XML menu is not available.

In what follows, each menu option is explained separately through a screen illustration, followed by a
table listing of the most important menu options.

 

File menu

The File menu is dedicated to managing project (and project resource) files via a number of functions,
illustrated in the following screen and described in the table below.
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File menu option Function
New Use to create a new project, map, topic, image, or any other resource file

Close (All) Use to properly close an open file (or all open files)

Save (All) Use to save current file, whose tab is highlighted in the editing area (or all open
files)

Revert Ignore changes made to file and revert to copy on disk
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Move Use to move a resource file within the current project or across projects

Rename Use to rename a resource file that is highlighted in the Project Explorer view

Refresh Refresh current element

Print Use to invoke the file print wizard

Switch Workspace Use to switch between one or more local and server work spaces

Restart Use to restart the application

Import Use to import content or model resources from context project, from another
project, or from an external repository to a selected folder

Export Use to export content or model resources from context project, from another
project, or from an external repository to a selected folder

Properties Use to invoke the Properties for window, where you can set a number of editing
choices

Edit menu

The Edit menu is dedicated to performing functions related to the handling of file text and markup. It
applies only to open file content within the editor view.

 

Edit menu option Function
Undo Typing (Redo) Use to reverse (or re-instate) the last typing action

Cut, Copy, Paste Use to cut or copy contiguous highlighted text and keep it on clipboard (or text on
clipboard)

Delete Use to delete current file

Select All Use to select and highlight all text in current file
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Find (Replace) Use to search for text by string (and to replace each found string by another)

Add Bookmark (Task) Use to add an element or a resource file (or a task you need to carry on later) to a
bookmark list that could be made visible from the View menu

Navigate menu

The Navigate menu supports the user in finding and moving across resources and work areas.
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Navigate menu option Function
Go Into Navigate within the context container

Open Resource Invokes a window with a similar function to the object selector function

Show In This sub-menu is used to find and select the currently selected resource in another
view. If an editor is active, these commands are used to select the resource
currently being edited in another view.

Next (Previous)
Annotation

Browse through previously created annotations

Back (Forward) Navigate via history of open files

Search menu

The Search menu helps you find project resources by performing a content text based search, with
the aid of regular expressions.

 

Search menu option Function
File Use to search within a file using regular expressions

Text Use to search within either of the following contexts using regular expressions:
Workspace: , Project: , File: , Working Set ...:

Project menu

The Project menu helps you manage content projects both in terms of setting project scope rules and
processing.
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Project menu option Function
Open (Close) Project Opens an existing project (or closes an open project)

Build All (Project) Rebuild all (or selected project) from workspace

Build Working Set Rebuild current working set

Clean Clean workspace from cached data and start rebuild

Build Automatically Trigger automatic rebuild when needed

Properties A dialog window used to set several project context properties

Window menu

The Window menu helps you customize the user interface and find the tools you may be looking for.

 

 

Window menu option Function
New Window Use to open a new workbench (application) window

New Editor Use to open a new editor area

Open Perspective » DITA
Editing / DITA Modeling

Use to open one of the two DITAworks perspectives

Show View Use to open up a view that is not currently showing in any docking area
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Save, Reset, Close (All)
Perspective(s)

Use to perform these basic operation on currently open perspectives

Navigation Use to access a menu of navigation related options

Preferences Use to set application context properties

Help menu

The Help menu provides DITAworks "Help pages" as well as application licensing, registering, and
updating related information.

 

 

Help menu option Function
Welcome Use to open the application's Welcome page, which has links to introductory

resources

Help Contents Use to open the Help Pages window

Search Use to search the Help Pages, without necessarily having the Help pop up window
open

Dynamic Help Use to open context-sensitive help for current UI control

License Use to register and verify the application's license

Software Updates Use to Access application updates

About Use to learn about the modules and platforms used in DITAworks and to obtain
version information
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 Context menus

Context menus are invoked by clicking the right mouse button while the cart is within a particular
editing view and/or while it is at a highlighted resource or object name (e.g. project folder, topic file,
highlighted element or text). Not all resource files have context menus. Also, not all context menu
options are covered by the main menu bar options. The options available from a context menu may
vary depending on the context it applies to.

The following resources/views are associated with context menus:

• Project Explorer objects context menu: The same context menu is available by right clicking a
project name, a folder names, or any resource file name.

• Map Manager view context menus: The same context menu is available by right clicking a topic
or a map name.

• Editor context menus: Depend on the editing mode

• Text

• Author

Project Explorer context menu

This menu is used to perform several project level operations, as illustrated and described in what
follows.
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Menu option Function
New Use to create a new project, map, topic, image, or any other resource file

Refresh Use to update the project workspace with files that have been created in the file
system, rather than the Project Explorer view itself, which cannot be identified by
the application otherwise (unless restarted)

Validate Use to validate a DITA XML file, all files within a folder, or all project files

DITA Decorations Use to invoke the decorations view which applies to a wide range of document
types

Remove CMS Nature Use to remove DITAworks mark from current project. This turns DITAworks Content
project in regular Eclipse project.

Team Use to perform a range of project version control functions, such as update,
commit, synchronize, etc.

Buckminster Use to invoke commands for Buckminster (tool for managing projects in repository)

Properties Use to invoke the project Properties dialog window
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Map Manager context menu

This menu applies to map or topic files within the Map Manager view. Options vary depending on the
context object.

 

Menu option Function
Edit Opens the highlighted file for editing

Focus on element Opens the DITA map file in the Structure view

Append Child Appends the context topic file with a topic file reference, topic head, or topic body

Insert before (after) Inserts a topic file reference before (or after) the context topic file

Link (Unlink) Links (or unlinks) DITA topic to/from current map element (changing href attribute)

Move Promotes (or demotes) the context topic file up or down the hierarchy

Expand (Collapse) all Expands (or collapses) all topic references that contain other references

Topic Text Editor context menu

This menu features text mode editing support functions. Options vary depending on whether the menu
is invoked from white space, or from a highlighted element or text.
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Menu option Function
Quick Fix Displays "Quick Fix" suggestions to fix validation errors

Shift Right (Left) Shifts the cursor line to the left (or right) by one tab

Add block to reuse Adds the context block to the central reuse repository and generates an ID (if one
does not exist)

Refactoring Provides sub-options to rename, split, join or surround context element with tags
you get to choose
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Topic Author Editor context menu

This menu features author mode editing support functions. Options vary depending on whether the
menu is invoked from white space, or from a highlighted element or text.

 

Menu option Function
Edit Attributes Opens an attribute editing window that shows only those attributes, which are valid

for the context element

Environment Opens reuse, preview, or tag view

Options Invokes a Preferences window, focused on Author mode options

Map Source Editor context menus

This menu is similar to the topic text editing mode menu.

A very useful feature in source mode is that when you position the cart over a topic reference, you get
a popup window displaying a formatted preview of the content of the context topic.

Map Structure Editor context menu

This menu provides support features to the map structure editing mode.
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Menu option Function
Append Child Use to append a child topic to be contained by the context topic

Insert Before (After) Use to insert a topic reference before (or after) the context topic

Move up (down) Use to move a topic up (or down) the topic containment hierarchy

Icon marker Use to attach a marker to the context topic, in the form of an icon among a choice
of several icons, to use a visual reminder for later action

Add comment Use to attach a comment, in the form of a callout box, to the context topic for later
action (comment can be deleted from its own context menu)

Properties Opens the context Properties view in its default pane
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Publishing Parameters
Publishing in DITAworks is based on DITA Open Toolkit. DITAworks provides a way to override
certain DITA Open Toolkit parameters, accessible through the Create new configurations window's
Advanced hyper link.

The following tables summarize the processing parameters available in the following categories:
general, general for tasks, eclipsehelp, eclipsehelpwithcontexts, eclipsecontent,
htmlhelp, javahelp, xhtml, and PDF fo.

General Parameters

Parameter Description Required?
basedir The path of the working directory for transformations,

which will be the base of relative paths specified by
other parameters

• If input is relative, it will be set relative to the
current directory

• In Ant scripts, the default is that specified in the
Ant build file

• In Java command line, the default is current
directory

No

dita.dir The absolute path of the toolkit's home directory No

args.input The path and name of the input file; should be named
using the same case (upper/lower) used in the file
system filename

This parameter must be provided if dita.input and
dita.input.dirname are not provided

No

dita.input The name of the input file

• This parameter must be provided if args.input
is not provided

• This parameter must be used together with the
dita.input.dirname parameter

• The combination is equivalent to only using the
args.input parameter

• It is an alternative way to specify the path and
name of the input file.

Deprecated - use args.input instead

No

dita.input.dirname The input directory which contains the input file

• This parameter must be provided if args.input
is not be provided

No
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Parameter Description Required?
• This parameter must be used together with the
dita.input parameter

• The combination is equivalent to using only the
args.input parameter; it is an alternative way
to specify the path and name of the input file

Deprecated - use args.input instead

dita.temp.dir The directory of the temporary files; default is temp No

output.dir The path of the output directory Yes

dita.extname The file extension name of the input topic files; for e.g.
'.xml' or '.dita'; default is '.xml'

No

args.xsl The xsl file to replace the default xsl file;

Replaces dita2docbook.xsl in docbook
transformation, dita2fo-shell.xsl in pdf
transformation, dita2xhtml.xsl in xhtml/
eclipsehelp transformation, dita2rtfImpl.xsl
in word transformation, and dita2html.xsl in
javahelp/htmlhelp transformation

No

dita.input.valfile The name of the file containing filter/flagging/revision
information

No

args.draft Causes the output to show draft-comment and
required-cleanup content in plainly-marked style for
review

“no”  and  “yes”  are valid values

No

args.artlbl Causes the output to include the file name of each
graphic (useful for recapturing screen images after
translation, for example).

“no” and  “yes” are valid values

No

clean.temp The parameter to specify whether to clean the temp
directory before each build; only "no" and "yes" are
valid values; default is yes

No

args.logdir The directory used to keep generated log files. Default
will be the output directory

If several transforms run in batches, for e.g. ant all:

• If the user specified a common logdir for all
transformations, it is used as log directory

• If the user did not specify a common dir for all
transformations:

• If all transformations have same output
directory, the common output direcory will
be used as log directory

No
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Parameter Description Required?
• If there is no same output directory for all

transformations, the basedir will be used
as default log directory

validate The parameter to specify whether the ditamap/dita/xml
files to be validated. Only "true" and "false" are valid
values; default is true

It is not recommended to turn off the validation
function, which will cause unexpected errors during
transformation

No

outer.control The parameter to specify how to respond to the
overflowing dita/topic files; only 'fail', 'warn' and 'quiet'
are valid values; default is warn

The detailed introduction:

• fail: Fail quickly if files are going to be generated/
copied outside of that directory

• warn: Complete if files will be generated/copied
outside, but log a warning

• quiet: Quietly finish with only those files (no
warning or error)

No

generate.copy.outer The parameter to specify how to deal with the
overflowing dita/topic files; only '1', '2', and '3' are valid
values; default is '1'

• '1': Only generate/copy files that fit within the
designated output directory

• '2': Generate/copy all files, even those that will
end up outside of the output directory

• '3': the old solution, adjust the input.dir
according to the referenced files (not a default
option any more, kept as an option for backward
compatibility)

No

onlytopic.in.map The parameter to specify whether the referenced dita/
topic files which are not referenced by ditamap files
should be resolved, only 'true' and 'false' are valid
values, default is false

No

preprocessing.script The Ant script file for execution before main
publication transformation

No

postprocessing.script The Ant script file for execution after main publication
transformatio

No

General parameters for tasks (xhtml, htmlhelp, javahelp, eclipsehelp,
eclipsehelpwithcontexts)
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Parameter Description Required?
args.indexshow The parameter to specify whether each index entry

should display within the body of the text itself. Only 'no'
and 'yes' are valid values

No

args.copycss The parameter to specify whether copy user
specified css files to the directory specified by
{args.outdir}${args.csspath}, 'no' and yes are
valid values, default is 'no'

No

args.outext The output file extension name for generated xhtml files;
typically, '.html' or '.htm' can be used as the extension
name for the generated xhtml files, you can also specify
other extension name, default is '.html'

No

args.css User specified css file, it can be a local file or remote file
from website

If ${args.csspath} is an URL, the ${args.css}
should be a file path relative to the URL

No

args.cssroot The root directory of user specified css file.

If this parameter is set, the ${args.css} should be a
filepath relative to args.cssroot

No

args.csspath The path for css reference; Default is no path

• If ${args.csspath} is a URL like path, it
should start with http:// or https://, for e.g.
http://www.ibm.com/css

• Local absolute path is not supported for
${args.csspath}

• Use '/' as the path separator and don't append
separator at end of path (e.g. css/mycss is
correct)

No

args.hdf The name of the file containing XHTML to be placed in
the HEAD area

No

args.hdr The name of the file containing XHTML to be placed in
the BODY running-heading area.

No

args.ftr The name of the file containing XHTML to be placed in
the BODY running-footing area

No

eclipsehelp, eclipsehelpwithcontexts parameters

Parameter Description Required?
args.eclipsehelp.toc The root file name of the output eclipsehelp toc

file in eclipsehelp transformation; default is the
name of input ditamap file

No

args.eclipse.provider The provider name of the eclipse help output;
default value is DITA

No
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Parameter Description Required?
args.eclipse.version The version number of the eclipse help output;

default value is '1.0'
No

eclipsecontent parameters

Parameter Description Required?
args.eclipsecontent.toc The root file name of the output Eclipse

content provider toc file in eclipsecontent
transformation; default is the name of input
ditamap file

No

args.eclipse.provider The provider name of the eclipse help output;
default value is DITA

No

args.eclipse.version The version number of the eclipse help output;
default value is '1.0'

No

htmlhelp parameters

Parameter Description Required?
args.dita.locale The locale is used for sorting indexterms

If no locale is specified, the first occurrence of
'xml-lang' will be used as the default locale; if no
'xml-lang' is found, 'en-us' is used as default

No

args.htmlhelp.includefile The parameter to specify the file that needs to be
included by the HTMLHelp output

No

javahelp parameters

Parameter Description Required
args.javahelp.toc The root file name of the output javahelp toc file

in javahelp transformation; default is the name of
input ditamap file

No

args.javahelp.map The root file name of the output javahelp map file
in javahelp transformation; default is the name of
input ditamap file

No

args.dita.locale The locale is used for sorting indexterms No

xhtml parameters

Parameter Description Required
args.xhtml.toc The root file name of the output xhtml toc file in

xhtml transformation; default is 'index'
No
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pdf parameters

Parameter Description Required?
args.fo.img.ext The extension name of image file in pdf

transformation. Only '.jpg', '.gif' are valid value; the
default is '.jpg'

Only one extension is supported in the same
transformation; image files with other extensions
will be renamed to the specified extension

No

args.fo.output.rel.links This parameter specifies whether processor should
output related links in pdf transformation; 'yes' and
'no' are valid values, default is 'no'

No

args.fo.userconfig The parameter to specify the user configuration file
for FOP

No
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Eclipse Help Plugin Content Model
eclipsehelpplugin is a domain specialization of ditamap, whose purpose is to facilitate the
integration of generated Help Pages with the Eclipse software development platform. This integration
enables several desirable features for Eclipse developers, such as:

• Generating Eclipse Help from the Eclipse development environment

• Calling specific help pages by the developers

• Taking advantage of Eclipse Live Help where Java code snippets could be called from within the
Help Pages to guide the developer through accomplishing a certain programming task.

The rest of this chapter provides a formal content model documentation of Eclipse Help Plugin, in
accordance with the conventions of OASIS DITA language specifications.

Doctype for all <eclipsehelpplugin> elements is <ditamap>

 eclipsehelpplugin

The root container element for eclipsehelp plugin map.

Example

<eclipsehelpplugin id="eclipsehelpplugin_270">
    <manifest-info>
        <Bundle-Version>1.1.4</Bundle-Version>
        <Bundle-Name>DITAworks editing documentation</Bundle-Name>
        <Bundle-Vendor>*instinctools GmbH</Bundle-Vendor>
        <Bundle-SymbolicName>com.go.dita.editing.doc</Bundle-SymbolicName>
    </manifest-info>
    <tocs>
        <tocfile format="dita" href="../Editing_Top_TOC.ditamap" primary="true"/>
    </tocs>
    <contexts>
        <contextsfile format="dita" href="../contexts/
com.go.dita.editing.ui.ditamap" plugin="com.go.dita.editing.ui"/>
        <contextsfile format="dita" href="../contexts/com.go.cms.preview.ditamap"
 plugin="com.go.cms.preview"/>
    </contexts>
    <cheatsheets>
        <cheatsheet composite="false" contentFile="../cheatsheets/
Create_New_Content_Project.xml" id="Create_New_Content_Project" name="Create New
 Content Project"/>
    </cheatsheets>
</eclipsehelpplugin>

Contains

(title?, manifest-info?, plugin-properties?, tocs?, contexts?, cheatsheets?)

Contained by

None

Inheritance

- map/map eclipsehelpplugin/eclipsehelp
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Attributes

Name Description Data Type Default
Value

Required?

domains Indicates the specialized domains that are included
in the DTD or Schema

CDATA &included-
domains;

Required

id The ID enables an eclipsehelpplugin map to
be uniquely referenced from another map

NMTOKEN None Optional

title Contains a heading or label for the plugin CDATA None Optional

 Bundle-Name

Specifies the name of the plugin bundle. This is one of the mandatory parameters for Eclipse help
plugin Manifest file.

Example

<Bundle-Name>DITAworks editing documentation</Bundle-Name>

Contains

Empty

Contained by

<manifest-info>

Inheritance

- eclipsehelpplugin/data eclipsehelpplugin/Bundle-Name

Attributes

None

 Bundle-SymbolicName

Assigns an identifier name to the plugin bundle.

Example

<Bundle-SymbolicName>com.go.dita.editing.doc</Bundle-SymbolicName>

Contains

Empty

Contained by

(<manifest-info>)

Inheritance

- eclipsehelpplugin/data eclipsehelpplugin/Bundle-SymbolicName

Attributes

None
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 Bundle-Version

Specifies the version of the plugin bundle.

Example

<Bundle-Version>1.1.4</Bundle-Version>

Contains

Empty

Contained by

<manifest-info>

Inheritance

- eclipsehelpplugin/data eclipsehelpplugin/Bundle-Version

Attributes

None

 cheatsheet

An element for defining reference to cheat sheet that has to be included into the final Eclipse Help
plugin. See details at http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/
reference/extension-points/org_eclipse_ui_cheatsheets_cheatSheetContent.html

Example

<cheatsheet>
    composite="false" 
    contentFile="../cheatsheets/Create_New_Content_Project.xml" 
    id="Create_New_Content_Project" 
    name="Create New Content Project"/>

Contains

description

Contained by

cheatsheets

Inheritance

- map/topicref eclipsehelpplugin/cheatsheets

Attributes

Name Description Data
Type

Default
Value

Required?

id A unique ID of the cheat sheet. This ID will be used for
references from other places. This attribute is transformed
into the id attribute of cheatsheet element of plugin.xml.

CDATA None Required

http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/reference/extension-points/org_eclipse_ui_cheatsheets_cheatSheetContent.html
http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/reference/extension-points/org_eclipse_ui_cheatsheets_cheatSheetContent.html
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name Symbolic name for cheat sheet. This attribute is
transformed into name attribute of cheatsheet element of
plugin.xml.

CDATA None Required

category Reference to cheat sheet category for this cheat sheet.
Categories are declared using cheatsheet-category
[page 109] element. This attribute is transformed into
cheatsheet-category attribute of cheatsheet element
of plugin.xml.

CDATA None Optional

contentFile Reference to to actual cheat sheet file. This should be a
reference to xml file with cheat sheet definition as described
in Eclipse specification. See details here.

CDATA None Optional

listener A fully qualified name of a Java class which must subclass
org.eclipse.ui.cheatsheets.CheatSheetListener.

CDATA None Optional

scope Defines the scope of the reference. - external Fixed

format Identifies the format of the resource being cross referenced. - xml Fixed

composite Identifies whether the cheat sheet reference is composite or
not.

(false |
true)

None Required

 cheatsheet-category

Defines a category for cheat sheets. Categories defined like this will appear in list of all cheat sheets.

Contains

Empty

Contained by

cheatsheets

Inheritance

- map/topicref eclipsehelpplugin/cheatsheet-category

Attributes

Name Description Data
Type

Default
Value

Required?

id Unique ID for the cheat sheet category. This
ID will be used by cheat sheet definitions when
assigning cheat sheets to categories.

ID - Required

name Name for new cheat sheet category. CDATA - Required

parentCategory Reference to parent cheat sheet category ID in
case this category became a sub-category.

ID - Optional

 cheatsheets

A container element for defining one or more references to cheat sheets that has to be included into
the final Eclipse help plugin. Actual references to cheat sheets are done using  cheatsheet [page
108] element.

Example

<cheatsheets>

http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/guide/ua_cheatsheet_simple.htm
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    <cheatsheet composite="false" contentFile="../cheatsheets/
Create_New_Content_Project.xml" id="Create_New_Content_Project" name="Create New
 Content Project"/>
</cheatsheets>

Contains

(cheatsheet, taskEditor, taskExplorer), cheatsheet-category)+

Contained by

eclipsehelp

Inheritance

- map/topicref eclipsehelpplugin/cheatsheets

Attributes

Name Description Data Type Default
Value

Required?

id The ID enables unique referencing to this element. CDATA - Optional

 contextfile

contextsfile element is used to reference a container with Eclipse help context definitions. The
referenced container should be a DITA map of  eclipsecontexts [page 117] infotype. This
map is a collection of help context definitions in DITA format. Usually help contexts from one Eclipse
functional plugin are placed into separate context definition container.

Example

<contextsfile format="dita" href="../contexts/com.go.dita.editing.ui.ditamap"
 plugin="com.go.dita.editing.ui"/>

Contains

None

Contained by

contexts

Inheritance

- map/topicref eclipsehelpplugin/contextsfile

Attributes

Name Description Data Type Default
Value

Required?

format Format of referenced file. Only "dita" value is
allowed here.

dita - Required

href Reference to DITA map of 
eclipsecontexts [page 117] infotype.

CDATA - Required

plugin Name of functional plugin that is described by
referenced contexts.

CDATA .. Optional
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 contextprovider

contextprovider is used for the definition of dynamic context providers.

Contains

Empty

Contained by

contexts

Inheritance

- map/topicref eclipsehelpplugin/contextsprovider

Attributes

Name Description Data Type Default
Value

Required?

className Java class name of Context Provider CDATA - Required

 contexts

Eclipse Help contexts connect UI components with help topics. The contexts element is a container
for references to different help context definitions that are done using the contextfile [page 110]
element.

Example

<contexts>
    <contextsfile format="dita" href="../contexts/com.go.dita.editing.ui.ditamap"
 plugin="com.go.dita.editing.ui"/>
    <contextsfile format="dita" href="../contexts/com.go.cms.preview.ditamap"
 plugin="com.go.cms.preview"/>
</contexts>

Contains

(contextfile , contextprovider)

Contained by

eclipsehelp

Inheritance

- map/topicref eclipsehelpplugin/contexts

Attributes

Name Description Data Type Default
Value

Required?

id The ID enables uniquely referencing the
contexts

CDATA - Optional
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 description

Description element provides a way to define text description for parent cheat sheet.

Contains

Empty

Contained by

cheatsheet

Inheritance

- eclipsehelpplugin/data eclipsehelpplugin/description

Attributes

None

 manifest-info

Element is a container for several mandatory properties of Eclipse plugin manifest. These values will
be used for generating Manifest.MF file during Eclipse help transformation.

Example

<manifest-info>
  <Bundle-Version>1.1.4</Bundle-Version>
  <Bundle-Name>DITAworks editing documentation</Bundle-Name>
  <Bundle-Vendor>*instinctools GmbH</Bundle-Vendor>
  <Bundle-SymbolicName>com.go.dita.editing.doc</Bundle-SymbolicName>
</manifest-info>

Contains

(Bundle-Version, Bundle-Name, Bundle-Vendor Bundle-SymbolicName)

Contained by

eclipsehelp

Inheritance

- map/topicref eclipsehelpplugin/manifest-info

Attributes

None

 plugin-properties

A container for optional properties of Eclipse plugin manifest. Properties are defined using  property
[page 113] element.

Example

<plugin-properties>
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 <property propvalue="Bundle-ActivationPolicy: " propname="lazy" />
</plugin-properties>

Contains

property

Contained by

eclipsehelp

Inheritance

- map/topicmeta eclipsehelpplugin/plugin-properties

Attributes

Empty.

 property

Used to define optional properties of Eclipse plugin manifest.

Example

<property propvalue="Bundle-ActivationPolicy: " propname="lazy" />

Contains

Empty

Contained by

<plugin-properties>

Inheritance

- map/keywords eclipsehelpplugin/property

Attributes

Name Description Data Type Default
Value

Required?

propname Name of manifest property that is defined. CDATA - Required

propvalue Value of manifest property that is defined. CDATA - Required

 taskEditor

This is one of the parameters of cheat sheet extension point in eclipse. More details are available at
http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/reference/extension-
points/org_eclipse_ui_cheatsheets_cheatSheetContent.html

Contains

Empty

Contained by

cheatsheets

http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/reference/extension-points/org_eclipse_ui_cheatsheets_cheatSheetContent.html
http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/reference/extension-points/org_eclipse_ui_cheatsheets_cheatSheetContent.html
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Inheritance

- map/topicref eclipsehelpplugin/taskEditor

Attributes

Name Description Data Type Default
Value

Required?

id Enables uniquely referencing element. CDATA - Required

className Java class name of Task Editor implementation CDATA - Required

icon Task editor icon CDATA - Required

 taskExplorer

This is one of the parameters of cheat sheet extension point in eclipse. More detail is available at:
http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/reference/extension-
points/org_eclipse_ui_cheatsheets_cheatSheetContent.html.

Contains

Empty

Contained by

cheatsheets

Inheritance

- map/topicref eclipsehelpplugin/taskExplorer

Attributes

Name Description Data Type Default
Value

Required?

id Enables uniquely referencing element. CDATA - Required

className Java class name of Task Explorer implementation CDATA - Optional

icon Reference to image file for Task Explorer icon CDATA - Optional

name Task Explorer name CDATA - Required

 tocfile

Element is used for definition of references to tables of contents(TOCs) for eclipse help plugins.
Element should make references using href attribute any kind of DITA map or its specialization. In
process of transformation to eclipse help plugin, referenced DITA map will be transformed into toc.xml
file for Eclipse plugin and linked to appropriate extension point in plugin.xml.

Example

<tocfile format="dita" href="../Editing_Top_TOC.ditamap" primary="true"/>

Contains

Empty

http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/reference/extension-points/org_eclipse_ui_cheatsheets_cheatSheetContent.html
http://help.eclipse.org/ganymede/index.jsp?topic=/org.eclipse.platform.doc.isv/reference/extension-points/org_eclipse_ui_cheatsheets_cheatSheetContent.html
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Contained by

tocs

Inheritance

- map/topicref eclipsehelpplugin/tocfile

Attributes

Name Description Data Type Default
Value

Required?

format Format of reference. ?? dita Required

href Reference to any DITA map that represents TOC
for plugin.

CDATA - Required

primary Indicates whether this TOC is a primary TOC for
whole plugin. There could be only one primary
TOC defined for one plugin. Primary TOC is
displayed on root level of Eclipse help system.

(false | true) - Required

toc-
category

Reference TOC category. CDATA - Optional

 tocprovider

This element can used to define dynamic TOC providers. See following URL for more details: http://
www.eclipse.org/eclipse/platform-ua/documents/providers_api.html

Example

<tocProvider
            class="org.myproject.MyTocProvider">
      </tocProvider>

Contains

None

Contained by

toc

Inheritance

- map/topicref eclipsehelpplugin/tocprovider

Attributes

Name Description Data
Type

Default
Value

Required?

className The implementation class for the toc
provider. This class must implement the
org.eclipse.help.AbstractTocProvider
interface.

CDATA - Required

http://www.eclipse.org/eclipse/platform-ua/documents/providers_api.html
http://www.eclipse.org/eclipse/platform-ua/documents/providers_api.html
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 tocs

This is a container element for defining one or more tables of contents(TOCs) for future Eclipse help
plugin. Single TOCs are defined using  tocfile [page 114] element.

Example

<tocs>
    <tocfile format="dita" href="../Editing_Top_TOC.ditamap" primary="true"/>
</tocs>

Contains

tocfile

Contained by

<eclipsehelp>

Inheritance

- map/topicref eclipsehelpplugin/tocs

Attributes

Name Description Data Type Default
Value

Required?

id Enables element to be uniquely referenced. CDATA - Optional
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Eclipse Help Contexts Content Model
Eclipse Help contexts (eclipsecontexts) is a structural specialization of standard DITA <map>. Its
purpose is to enable definitions of Eclipse Help System-specific help contexts using DITA. This form
of user assistance is delivered by Eclipse Help System to users when help topics are integrated into
documented application and a platform specific trigger is activated (e.g. F1 key on Windows). Context
sensitive help can be associated with UI widgets statically or dynamically using context IDs.

One eclipsecontexts DITA map can contain definitions for many help contexts. Each context defines
description and set of topics or other references that form this help context. The structure of this
infotype is very similar to the target structure of Eclipse help context file, with some differences since
not all attributes are valid in the specialized map.

The rest of this chapter provides a formal content model documentation of Eclipse Help contexts, in
accordance with the conventions of OASIS DITA language specifications.

Doctype for all <eclipsecontexts> elements is -//XDOC//DTD DITA EclipseContexts
1.0//EN

 eclipsecontexts

This is a root container element for Eclipse help context definitions. This is a specialization of map
element.

Example

<eclipsecontexts>
  <context id="com.go.cms.preview.browser">
  <description>Provides an output display version of the DITA markup being edited</
description>
  <helpKey id="COM_GO_CMS_PREVIEW_UI_PREVIEWBROWSER"/>
  <topic format="dita" href="../../Topics/reference/Views.dita"/>
  </context>
</eclipsecontexts>

Contains

(title?, context*)

Contained by

None

Inheritance

- map/map eclipsecontexts/contexts

Attributes

Name Description Data Type Default Value Required?
class DITA class identifier CDATA - map/map

eclipsecontexts/
contexts

no
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 context

Element defining a single Eclipse help context. Specialization of map/topicref element.

Every context should define a unique ID (using attribute id) that will be used for references to this
context. Context definition also includes:

• Description: Text description about current help context.

• Zero or more helpKey assignments. These are mappings of helpKeys used in indirect mapping
strategy [page ].

• Zero or more topic references. Defines topics that will be included in current Eclipse context.

• Zero or more commands. Defines additional commands that will be included into current context.
In this way references to Cheat sheets [page ] can be done from Eclipse contexts.

Example

<context id="com.go.cms.preview.browser">
  <description>Provides an output display version of the DITA markup being edited</
description>
  <helpKey id="COM_GO_CMS_PREVIEW_UI_PREVIEWBROWSER"/>
  <topic format="dita" href="../../Topics/reference/Views.dita"/>
  <command serialization="org.eclipse.ui.cheatsheets.openCheatSheet
   (cheatSheetId=Create_New_Content_Project)"/>
</context>

Contains

(description?, helpKey*, (topic | command)*)

Contained by

<eclipsecontexts>

Inheritance

- map/topicref eclipsecontexts/context

Attributes

Name Description Data Type Default
Value

Required?

id Unique ID of Eclipse help context. This ID will be
used for addressing Eclipse context from Eclipse
application when using direct ID mapping strategy
or as mapping destination in indirect mapping
strategy.

id - yes

class DITA class identifier CDATA - map/
topicref
eclipsecontexts/
context

no
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 description

Text description for Eclipse help context. Content of this field will be displayed in "About" section of
Help View.

Example

 <description>Provides an output display version of the DITA markup being edited</
description>

Contains

#PCDATA

Contained by

<context>

Inheritance

- map/topicref eclipsecontexts/context

Attributes

Name Description Data Type Default Value Required?
class DITA class identifier CDATA - map/topicref

eclipsecontexts/
context

no

 helpKey

Element for defining helpKey assignments. Help keys are used as unique identifiers placed source
code when using indirect context ID mapping strategy [page ]. Help context can have zero or
more helpKey assignments.

Using a mandatory attribute id in helpKey element author can define unique ID of helpKey that should
match to ID defined in source code of calling application.

Example

<helpKey id="COM_GO_CMS_PREVIEW_UI_PREVIEWBROWSER"/>

Contains

Empty

Contained by

<context>

Inheritance

- map/topicref eclipsecontexts/helpKey
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Attributes

Name Description Data Type Default Value Required?
id Unique ID of help key. This ID will be used for

generating ID mappings in indirect mapping
strategy [page ].

id - yes

class DITA class identifier CDATA - map/topicref
eclipsecontexts/
helpKey

no

 title

Title of context definition map. This optional element is ignored during transformation to eclipse help
contexts.

Example

<title>My title.</title>

Contains

None.

Contained by

<contexts>

Inheritance

- map/title eclipsecontexts/title

Attributes

Name Description Data Type Default Value Required?
class DITA class identifier CDATA - map/title

eclipsecontexts/title
no

 topic

This element is used for defining reference from Eclipse help context to a topic. There could be zero or
more topic references under context.

Example

<context id="com.go.cms.preview.browser">
   <description>Provides an output display version of the DITA markup being
 edited</description>
   <topic format="dita" href="../../Topics/reference/Views.dita"/>
   <topic format="dita" href="../../Topics/reference/Perspectives.dita"/>
</context>

Contains

Empty

Contained by

<context>
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Inheritance

- map/topicref eclipsecontexts/topic

Attributes

Name Description Data
Type

Default
Value

Required?

format Defines a format of referenced content. Inherited from
level of topicref element, this attribute has only one
valid value dita.

CDATA dita yes

href Defines a reference to DITA topic. CDATA .. yes

locktitle yes|no .. no

navtitle Title for topic reference CDATA .. no

 command

This element is used for defining additional commands that will be included into current context.

Example

<command serialization="org.eclipse.ui.cheatsheets.openCheatSheet
 (cheatSheetId=Create_New_Content_Project)"/>

Contains

Empty

Contained by

<context>

Inheritance

- map/topicref eclipsecontexts/command

Attributes

Name Description Data
Type

Default
Value

Required?

serialization Defines a command in serialized form that
will be executed. Format of this attribute is
the same that is used in Eclipse cheat sheet
command definitions.

CDATA - yes
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Active help Domain Specialization
The activehelp domain specialization is used to support Active help [page 82] features in DITA
source topics. All elements of this specialization are inherited from topic/ph element and can appear
on any place where ph element is allowed in regular DITA content model.

 liveAction

liveAction element enables you to call active help Java Action from DITA source topic.

Example

<p>Set attributes for newly 
  <liveAction
 laclassName="org.eclipse.platform.doc.isv.activeHelp.ActiveHelpOpenDialogAction"
 laplugin="org.eclipse.platform.doc.isv" 
  >created </liveAction> element. </p>

Contains

None

Contained by

Any element that allows ph element.

Inheritance

+ topic/ph activehelp-d/liveAction

Attributes

Name Description Data
Type

Default
Value

Required?

la-className The name of the class that implements the
action

CDATA .. Required

la-plugin The ID of the plugin that contains the
action

CDATA .. Required

la-
initializationString

The String that will be passed
to the live help action using
setInitializationString (optional)

CDATA .. Optional

 executeCommand

executeCommand element enables you to call Eclipse command from DITA source topic.

Example

<p>Set attributes for newly 
  <executeCommand ec-command="org.eclipse.ui.help.aboutAction">created </
executeCommand> element. </p>



Active help Domain Specialization / executeCommand
DITAworks Guide for Authors

123

Contains

None

Contained by

Any element that allows ph element.

Inheritance

+ topic/ph activehelp-d/executeCommand

Attributes

Name Description Data
Type

Default
Value

Required?

ec-command Java class name of the Eclipse command
that should be called.

CDATA No Yes
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